BD LSRFortessa™ X-20
Cell Analyzer
User’s Guide
Copyrights

© 2020, Becton, Dickinson and Company. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in retrieval systems, or translated into any language or computer language, in any form or by any means: electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without prior written permission from BD Biosciences.

The information in this guide is subject to change without notice. BD Biosciences reserves the right to change its products and services at any time to incorporate the latest technological developments. Although this guide has been prepared with every precaution to ensure accuracy, BD Biosciences assumes no liability for any errors or omissions, nor for any damages resulting from the application or use of this information. BD Biosciences welcomes customer input on corrections and suggestions for improvement.

Trademarks

BD, the BD Logo, FACS, FACSDiva, FACSFlow, and FACSClean are trademarks of Becton, Dickinson and Company or its affiliates. All other trademarks are the property of their respective owners. © 2020 BD. All rights reserved.

Alexa Fluor™ and Pacific Blue™ are trademarks of Life Technologies Corporation.

Cy™ is a trademark of GE Healthcare. Cy™ dyes are subject to proprietary rights of GE Healthcare and Carnegie Mellon University and are made and sold under license from GE Healthcare only for research and in vitro diagnostic use. Any other use requires a commercial sublicense from GE Healthcare, 800 Centennial Avenue, Piscataway, NJ 08855-1327, USA.

Patents

APC-Cy7: US 5,714,386

Regulatory information

For Research Use Only. Not for use in diagnostic or therapeutic procedures.

Class 1 Laser Product
FCC information

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

NOTICE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his or her own expense. Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits. This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations. Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance information

NOTICE: This laboratory equipment has been tested and found to comply with the EMC and the Low Voltage Directives. This includes FCC, Part 15 compliance for a Class A Digital Device.

CAUTION: Any unauthorized modifications to this laboratory equipment may affect the Regulatory Compliance items stated above.

History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Change made</th>
</tr>
</thead>
<tbody>
<tr>
<td>23-11947-00</td>
<td>4/2013</td>
<td>Initial release</td>
</tr>
<tr>
<td>23-11947-01</td>
<td>10/2020</td>
<td>Removed references of FACSRinse and added BD Detergent Solution Concentrate in place of FACSRinse.</td>
</tr>
</tbody>
</table>
# Contents

## Chapter 1: About this guide
- What this guide covers ........................................ 10
- Conventions .................................................. 11
- About the BD LSRFortessa X-20 documentation .......... 11
- Instrument technical support ................................ 13

## Chapter 2: Introduction
- Instrument overview .......................................... 16
- Components .................................................. 17
- Fluidics ........................................................ 19
- Sheath and waste containers ................................. 23
- Optics .......................................................... 23
- Workstation .................................................... 27

## Chapter 3: Cytometer setup
- Starting the cytometer and computer ..................... 30
- Preparing the sheath container ............................. 31
- Removing air bubbles ....................................... 33
- Preparing the waste container ............................. 36
- Priming the fluidics ......................................... 39
- About the optical filters and mirrors ...................... 40
- Changing optical filters and mirrors ...................... 42
- Custom configurations and baselines .................... 43
### Chapter 4: Maintenance
- Maintenance overview ................................................. 46
- Cleaning the fluidics ................................................. 47
- Shutting down the cytometer ........................................ 49
- Flushing the system .................................................. 50
- Maintaining the waste management system .................... 52
- Replacing the waste air filter ....................................... 55
- Changing the sheath filter .......................................... 56
- Changing the Bal seal ............................................... 58
- Changing the sample tube O-ring ................................. 60

### Chapter 5: Optimizing cytometer settings
- Cytometer settings workflow ....................................... 64
- Verifying the configuration and user preferences ............ 66
- Running a performance check .................................... 68
- Setting up an experiment .......................................... 72
- Creating application settings ..................................... 76
- Recording compensation controls ............................... 79
- Calculating compensation .......................................... 82

### Chapter 6: Recording and analyzing data
- Data recording and analysis workflow .......................... 86
- Preparing the workspace .......................................... 87
- Recording data ....................................................... 88
- Analyzing data ....................................................... 91
- Reusing an analysis ................................................ 97

### Chapter 7: Technical overview
- About fluidics ...................................................... 100
- About optics ......................................................... 101
- About electronics .................................................. 112
About this guide

This chapter covers the following topics:

- What this guide covers (page 10)
- Conventions (page 11)
- About the BD LSRFortessa X-20 documentation (page 11)
- Instrument technical support (page 13)
What this guide covers

This guide describes the procedures necessary to operate and maintain your special order BD LSRFortessa™ X-20 cell analyzer. Because many cytometer functions are controlled by BD FACSDiva™ software, this guide also contains information about software features required for basic cytometer setup and operation.

This guide assumes you have a working knowledge of basic Microsoft® Windows® operation. If you are not familiar with the Windows operating system, see the documentation provided with your computer.
Conventions

Introduction

The following table lists the safety symbols used in this guide to alert you to potential hazards.

<table>
<thead>
<tr>
<th>Safety symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Symbol</strong></td>
</tr>
<tr>
<td><img src="image" alt="Caution alert" /></td>
</tr>
<tr>
<td><img src="image" alt="Biological hazard" /></td>
</tr>
<tr>
<td><img src="image" alt="Electrical hazard" /></td>
</tr>
<tr>
<td><img src="image" alt="Laser hazard" /></td>
</tr>
</tbody>
</table>

About the BD LSRFortessa X-20 documentation

Introduction

This topic describes the documentation available with the special order BD LSRFortessa X-20 cell analyzer.

Publication formats

This guide is provided in PDF format to provide an eco-friendly option. All content is also included in the BD FACSDiva software Help.
Help system

The help system installed with BD FACSDiva software includes all content from this guide and the documents listed below. Access the BD LSRFortessa X-20 help system from the Help menu in BD FACSDiva software. Internet access is not required to use the help system.

The help system is compiled from the following documents:

- **BD FACSDiva Software Reference Manual**: Includes instructions or descriptions for installation and setup, workspace components, acquisition controls, analysis tools, and data management. Access this manual from the BD FACSDiva Software Help menu (Help > Documentation > Reference Manual), or by double-clicking the shortcut on the desktop.

- **BD Cytometer Setup and Tracking Application Guide**: Describes how to use the BD® Cytometer Setup and Tracking (CS&T) features in BD FACSDiva software.

- **BD LSRFortessa X-20 Cell Analyzer Site Preparation Guide**: Contains specifications for:
  - Cytometer weight and size
  - Temperature and other environmental requirements
  - Electrical requirements

- **BD High Throughput Sampler User’s Guide**: Describes how to set up and operate the BD® High Throughput Sampler (HTS) option. It also contains a description of BD FACSDiva software features specific to the HTS.

- **BD FACSFlow Supply System User’s Guide**: Describes the optional automated sheath and waste fluid control system designed for use with the BD® LSR II, BD LSRFortessa™, and BD LSRFortessa X-20.
Instrument technical support

Introduction

This topic describes how to get technical assistance.

Contacting technical support

If technical assistance is required, contact your local BD Biosciences customer support representative or supplier.

When contacting BD Biosciences, have the following information available:

- Product name, part number, and serial number
- Version of BD FACSDiva software you are using
- Any error messages
- Details of recent system performance

To contact customer support:

2. Select your region. You see information in your local language.
3. Click Go.
4. Click the Support link for details for your local region.
This page intentionally left blank
Introduction

This chapter covers the following topics:

- Instrument overview (page 16)
- Components (page 17)
- Fluidics (page 19)
- Sheath and waste containers (page 23)
- Optics (page 23)
- Workstation (page 27)
Instrument overview

The special order BD LSRFortessa X-20 cell analyzer is an air-cooled multi-laser benchtop flow cytometer with the ability to acquire parameters for a large number of colors. It uses fixed-alignment lasers that transmit light through a flow cell to configurable polygon detector arrays. These detectors collect and translate the resulting fluorescence signals into electronic signals. Cytometer electronics convert these signals into digital data.
# Components

**Introduction**

This topic describes the instrument’s components.

**Instrument overview**

- Heat ventilation slots
- Power switch (right side)
- Sample injection port (SIP)
- Control panel
- Side drawer (polygon detector arrays)

**Caution!** Do not place any objects on top of the instrument. Blocking the ventilation may cause the instrument to overheat.
Caution: Electrical Hazard! Do not place liquids on top of the instrument. Any spill of liquid into the ventilation openings could cause electrical shock or damage to the instrument.

**Power switch**
The power switch is located on the right side of the instrument.

**Control panel**
The control panel contains the following fluidics controls:

- Sample flow rate control buttons
- Fluid control buttons
- Sample fine adjust knob

The control panel contains the following system indicators:

- Acquisition status
- System power

---

**More information**

- Fluidics (page 19)
- Optics (page 23)
Fluidics

Introduction
This topic describes the fluidics system.

Purpose
The purpose of the fluidics system is to carry the sample out of the sample tube and into the sensing region of the flow cell. Cells are carried in the sample core stream in single file and measured individually.

Sample flow rate control
Three flow rate control buttons (LOW, MED, and HIGH) set the sample flow rate through the flow cell. The SAMPLE FINE ADJ knob allows you to adjust the rate to intermediate levels.

When the SAMPLE FINE ADJ knob is at its midpoint, the sample flow rates at the LOW, MED, and HIGH settings are approximately 12, 35, and 60 µL/min of sample, respectively. The knob turns five full revolutions in either direction from its midpoint, providing sample flow rates from 0.5–2X the midpoint value. For example, if the LOW button is pressed, the knob will give flow rates from approximately 6–24 µL/min.
Fluid control

Three fluid control buttons (RUN, STANDBY, and PRIME) set the cytometer mode.

- **RUN.** Pressurizes the sample tube to transport the sample through the sample injection tube and into the flow cell.

  The RUN button is green when the sample tube is on and the support arm is centered. When the tube support arm is moved left or right to remove a sample tube, the cytometer switches to an automatic standby status to conserve sheath fluid, and the RUN button changes to orange.

- **STANDBY.** Stops fluid flow to conserve sheath fluid.

  When you leave the cytometer for more than a few minutes, place a tube containing 1 mL of deionized (DI) water on the sample injection port (SIP) and press STANDBY.

- **PRIME.** Prepares the fluidics system by draining and filling the flow cell with sheath fluid.

  The fluid flow initially stops and pressure is reversed to force fluid out of the flow cell and into the waste container. After a preset time, the flow cell fills with sheath fluid at a controlled rate to prevent bubble formation or entrapment. At completion, the cytometer switches to standby mode.

System indicators

The two system indicators (ACQUISITION STATUS and SYSTEM POWER) show the current status of the cytometer.

- **ACQUISITION STATUS.** The light is green when the sample is being acquired by the cytometer.

- **SYSTEM POWER.** The light is blue when the cytometer power is on.
**Sample injection port**

The SIP is where the sample tube is installed. The SIP includes the sample injection tube and the tube support arm. Samples are introduced through a stainless steel injection tube equipped with an outer droplet containment sleeve. The sleeve works in conjunction with a vacuum pump to eliminate droplet formation of sheath fluid as it backflushes from the sample injection tube.

**Sample injection tube.** Stainless steel tube that carries sample from the sample tube to the flow cell. This tube is covered with an outer sleeve that serves as part of the droplet containment system.

**Tube support arm.** Arm that supports the sample tube and activates the droplet containment system vacuum. The vacuum is on when the arm is positioned to the side and off when the arm is centered.

**Note:** If a sample tube is left on the SIP with the tube support arm to the side (vacuum on), the sample will be aspirated into the waste container.
Cautions when using the HTS option

Caution: Biohazard! When using the BD LSRFortessa X-20 cell analyzer with the HTS, ensure that the HTS is completely pushed into the operating position before removing the droplet containment module (DCM) sleeve or disconnecting the sample coupler from the SIP. This is to avoid accidental leakage of potentially biohazardous liquids directly onto the instrument. With the HTS in the proper location, the containment dish with padding is directly below the SIP.

Caution! If you are using the HTS option, always slide the HTS mount slowly to prevent sample cross-contamination when the wells are full. Never move the HTS when it is in operation.

Caution! Do not lean on or put any weight on the HTS as it could damage the instrument.

Droplet containment module

The DCM prevents sheath fluid from dripping from the SIP and provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid backflushes through the sample injection tube. This backflush helps prevent carryover of cells between samples. The DCM vacuum is activated when the sample tube is removed and the tube support arm is moved to the side. Sheath fluid is aspirated as it backflushes the sample injection tube.
Sheath and waste containers

Introduction
This topic describes the sheath and waste containers. The sheath and waste containers are outside the cytometer and are positioned on the floor.

Note: If your system is using the BD FACSFlow™ supply system, please see the documentation provided with your system.

Sheath container
The sheath container has a capacity of 8 L. Sheath fluid is filtered through an in-line, interchangeable filter that prevents small particles from entering the sheath fluid lines.

Caution! Do not fill the sheath tank to its maximum capacity (8 L). When an overfull tank is pressurized, erratic cytometer performance can result.

Waste container
The waste container has a capacity of 10 L. An alarm sounds when the container becomes full.

More information
- Preparing the sheath container (page 31)
- Preparing the waste container (page 36)

Optics

Introduction
This topic describes the optical components for the special order BD LSRFortessa X-20 cell analyzer including:

- Detector arrays
- Laser options
- Optical filters
- Signal detectors
Detector arrays

The BD LSRFortessa X-20 detector arrays consist of polygons. Each polygon can be outfitted with two to eight PMTs and can detect up to eight signals.

Laser options

The special order BD LSRFortessa X-20 cell analyzer can be configured with up to five lasers as listed in the following table. The cytometer can also be configured with up to five lasers from a variety of wavelengths and powers through our special order research program.

<table>
<thead>
<tr>
<th>Laser</th>
<th>Wavelength (nm)</th>
<th>Power (mW)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>488</td>
<td>50</td>
</tr>
<tr>
<td>Red</td>
<td>640</td>
<td>40</td>
</tr>
<tr>
<td>Violet</td>
<td>405</td>
<td>50</td>
</tr>
<tr>
<td>NUV</td>
<td>375</td>
<td>50</td>
</tr>
<tr>
<td>Yellow-green</td>
<td>561</td>
<td>50</td>
</tr>
</tbody>
</table>
Optical filters

Optical filters attenuate light or help direct it to the appropriate detectors. The name and spectral characteristics of each filter appear on its holder.

There are two types of optical filters in the BD LSRFortessa X-20:

- **Longpass dichroic filters (LPs)**. Transmit wavelengths that are longer than the specified value and reflect all light below the specified wavelength.

- **Bandpass filters (BPs)**. Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different color light signals to different detectors, they are called dichroic mirrors. LP dichroic mirrors transmit longer wavelengths to one detector while reflecting shorter wavelengths to a different detector.

The BD LSRFortessa X-20 cell analyzer polygon detector arrays use dichroic longpass mirrors on the inside, and bandpass filters on the outside of the filter holders. You can customize the arrays with other wavelengths of filters and mirrors.
Signal detectors

Light signals are generated as particles pass through the laser beam in a fluid stream. When these optical signals reach a detector, electrical pulses are created that are then processed by the electronics system.

There are two types of signal detectors in the BD LSRFortessa X-20 cell analyzer:

- **Photomultiplier tubes (PMTs).** Used to detect the weaker signals generated by side scatter and all fluorescence channels. These signals are amplified by applying a voltage to the PMTs.

- **Photodiodes.** Less sensitive to light signals than the PMTs. A photodiode is used to detect the stronger forward scatter (FSC) signal. However, an optional PMT for detecting FSC is available through the BD special order research program.

More information

- Optical filter theory (page 104)
- About the base configuration (page 133)
- Special order configurations (page 150)
## Workstation

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This topic describes the components of the BD LSRFortessa X-20 workstation.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workstation components</strong></td>
<td>Acquisition, analysis, and most instrument functions are controlled by the BD LSRFortessa X-20 workstation. It includes a PC, one or two monitors, and a printer.</td>
</tr>
<tr>
<td></td>
<td>Your workstation is equipped with the following:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Windows operating system</td>
</tr>
<tr>
<td></td>
<td>• BD FACSDiva software version 7.0 or later for data acquisition and analysis</td>
</tr>
<tr>
<td></td>
<td>• Software documentation including the help system</td>
</tr>
<tr>
<td><strong>More information</strong></td>
<td>• About the BD LSRFortessa X-20 documentation (page 11)</td>
</tr>
</tbody>
</table>
This page intentionally left blank
Cytometer setup

This chapter covers the following topics:

- Starting the cytometer and computer (page 30)
- Preparing the sheath container (page 31)
- Removing air bubbles (page 33)
- Preparing the waste container (page 36)
- Priming the fluidics (page 39)
- About the optical filters and mirrors (page 40)
- Changing optical filters and mirrors (page 42)
- Custom configurations and baselines (page 43)
Starting the cytometer and computer

**Introduction**

This topic describes how to start the cytometer and turn on the computer.

**Note:** If your system is using the BD FACSFlow supply system, make sure that the BD FACSFlow supply system is powered on before the cytometer.

**Procedure**

To start the cytometer:

1. Turn on the power to the flow cytometer.

2. Allow 30 minutes for the optical system temperature to stabilize.

   **Caution!** Failure to warm up and stabilize the instrument could affect sample data.

3. Turn on the computer and log in to Windows.

   **Note:** You can turn on the power to the flow cytometer and the workstation in any order.

4. Start BD FACSDiva software by double-clicking the shortcut on the desktop, and log in to the software.

5. Check the Cytometer window in BD FACSDiva software to ensure that the cytometer is connected to the workstation.

   The cytometer connects automatically. While connecting, the message *Cytometer Connecting* is displayed in the status area of the Cytometer window. When connection completes, the message changes to *Cytometer Connected.*
If the message \textit{Cytometer Disconnected} appears, see Electronics troubleshooting (page 127).

\section*{Preparing the sheath container}

\begin{itemize}
  \item [Introduction] This topic describes how to prepare the sheath container.
  \item [Note:] If your system is using the BD FACSFlow supply system, please see the documentation provided with your system.
  \item [When to check the sheath container] Check the fluid levels in the sheath container every time you use the cytometer. This ensures that you do not run out of sheath fluid during an experiment.
\end{itemize}
To prepare the sheath container:

1. Verify that the flow cytometer is in standby mode.
   - Press the STANDBY button on the control panel if necessary.

2. Disconnect the green air line from the sheath container.

3. Depressurize the sheath container by pulling up on the vent valve.

4. Remove the sheath container lid.
   - Unscrew the clamp knob and push down to loosen, if necessary. Tilt the cap to the side to remove it from the tank.
5. Add 6 L of sheath fluid, such as BD FACSFLOW solution, to the sheath container.

   **Caution!** Do not fill the sheath tank to its maximum capacity (8 L). When an overfull tank is pressurized, erratic cytometer performance can result.

6. Replace the sheath container lid.

7. Reconnect the green air line.

8. Make sure the gasket on the inside lip of the sheath lid is seated correctly and has not slipped out of position.

   If the gasket is not seated correctly, the tank will not pressurize properly.

9. Close the sheath lid and tighten the clamp knob to finger-tight. Ensure that the blue sheath fluid line is not kinked.

---

**More information**

- Removing air bubbles (page 33)
- Changing the sheath filter (page 56)

---

**Removing air bubbles**

**Introduction**

This topic describes how to remove trapped air bubbles in the sheath filter and the sheath line. Air bubbles can occasionally dislodge and pass through the flow cell, resulting in inaccurate data.
Procedure

To remove air bubbles:

1. Check the sheath filter for trapped air bubbles.

2. If bubbles are visible, gently tap the filter body with your fingers to dislodge the bubbles and force them to the top.

**Caution!** When removing air bubbles, do not vigorously shake, bend, or rattle the sheath filter or you might damage it.
3. Direct the vent line into a beaker and press the small button at the end of the vent fitting against the side of the beaker until a steady stream of fluid empties from the filter.

4. Tilt the filter and verify that no trapped air remains in the filter.

5. Repeat steps 3 and 4 until no air is observed in the filter.

6. Check the sheath line for air bubbles.

7. Open the roller clamp at the fluidics interconnect (if necessary) to bleed off any air in the line. Collect any excess fluid in a waste container.

8. Close the roller clamp.
## Preparing the waste container

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This topic describes how to prepare the waste container.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If your system is using the BD FACSFlow supply system,</td>
</tr>
<tr>
<td></td>
<td>please see the documentation provided with your system.</td>
</tr>
<tr>
<td><strong>Caution: Biohazard!</strong></td>
<td>All biological specimens and materials coming into</td>
</tr>
<tr>
<td></td>
<td>contact with them are considered biohazardous. Handle</td>
</tr>
<tr>
<td></td>
<td>as if capable of transmitting disease. Dispose of</td>
</tr>
<tr>
<td></td>
<td>waste using proper precautions and in accordance with</td>
</tr>
<tr>
<td></td>
<td>local regulations. Never pipette by mouth. Wear suitable</td>
</tr>
<tr>
<td></td>
<td>protective clothing, eyewear, and gloves.</td>
</tr>
</tbody>
</table>

| **When to check the waste container**            | Check the fluid levels in the waste container every time |
|                                                 | you use the cytometer. This ensures that the waste       |
|                                                 | container does not become too full.                      |
Cautions

**Caution: Biohazard!** To avoid leakage of biohazardous waste, put the cytometer in standby mode before disconnecting the waste container.

**Caution: Biohazard!** The waste container contents might be biohazardous. Treat contents with bleach (10% of total volume).
Procedure

To prepare the waste container:

1. Verify that the flow cytometer is in standby mode.
   Press the STANDBY button on the control panel if necessary.

2. Disconnect the orange waste tubing and the black level sensor line from the waste container.
   Keep the lid on the waste container until you are ready to empty it.

3. Empty the waste container.

   **Caution!** The waste container is heavy when full. When emptying it, use good body mechanics to prevent injury.

4. Add approximately 1 L of bleach to the waste container and close it.

5. Reconnect the orange waste tubing and make sure it is not kinked.

6. Reconnect the level sensor line.

**Caution!** If the air vent filter on the top of the waste container cap assembly becomes clogged, air cannot be vented from the container, causing it to swell under pressure. If you observe swelling of the waste container, loosen the cap to relieve the pressure, and immediately replace the air filter. See *Replacing the waste air filter (page 55)* for instructions. Removing the air filter or the waste container cap assembly without first relieving the pressure might generate an unnoticeable aerosol. Use appropriate precautions when troubleshooting a clogged air filter. Wear suitable protective clothing, eyewear, and gloves.
# Priming the fluidics

**Introduction**

This topic describes how to prime the fluidics system.

**When to prime the fluidics**

Sometimes, air bubbles and debris may become lodged in the flow cell. This is indicated by excessive noise in the forward and side scatter parameters (FSC and SSC, respectively). In these cases, it is necessary to prime the fluidics system.

**Procedure**

To prime the fluidics:

1. Move the tube support arm to the side.
2. Remove the tube from the SIP.
3. Press the PRIME fluid control button to force the fluid out of the flow cell and into the waste container.

   Once drained, the flow cell automatically fills with sheath fluid at a controlled rate to prevent bubble formation or entrapment. The STANDBY button turns amber after completion.

4. Repeat the priming procedure, if necessary.
5. Install a 12 x 75-mm tube with 1 mL of DI water on the SIP and place the support arm under the tube. Leave the cytometer in standby mode.

**More information**

- Cytometer troubleshooting (page 118)
About the optical filters and mirrors

Introduction

This topic provides a description of the optical filters and mirrors.

Filter and mirror configurations

Each PMT has an optic holder in front of it. The optic holders are labeled with numbers indicating the wavelengths of the bandpass filter and longpass dichroic mirror they contain (for example, 695/40 and 685 LP, respectively). The optic holder in front of the last PMT in the detector array contains only a bandpass filter and is marked accordingly.

The filters steer progressively shorter wavelengths of light to the next PMT in the array as indicated by the lines and arrows on the top of the polygon.
Optic holders, filters, and mirrors

Optic holders house filters and mirrors. Your cytometer includes several blank (empty) optic holders.

Caution! To ensure data integrity, do not leave any slots empty in a detector array when you are using the associated laser. Always use a blank optic holder.

Base configurations

Each BD LSRFortessa X-20 cell analyzer has a base cytometer configuration that corresponds to the layout of the installed lasers and optics in your cytometer. This base configuration is set by your field service engineer.

BD FACSDiva cytometer configuration

Before you acquire data using BD FACSDiva software, you must specify a cytometer configuration. The cytometer configuration defines which filters and mirrors are installed at each detector.

BD FACSDiva software provides a BD base configuration for your BD LSRFortessa X-20 cell analyzer. Select Cytometer > View Configuration to create, modify, or delete custom cytometer configurations. (See the Cytometer and Acquisition Controls chapter of the BD FACSDiva Software Reference Manual for details.)

More information

- Changing optical filters and mirrors (page 42)
- About the base configuration (page 133)
- Special order configurations (page 150)
Changing optical filters and mirrors

Introduction
This topic describes how to verify that the optical filters are in the appropriate position for your particular requirements. Before you run samples, you must set up the optical filters.

Caution: Laser Hazard! Follow the precautions outlined in the BD LSRFortessa X-20 Safety and Limitations Guide while changing optical filters or mirrors.

Procedure
To change a filter or mirror:
1. Access the appropriate detector array.
   Polygon detector arrays are located in the left side cytometer drawer.
2. Remove the appropriate optic holder.
3. Replace the removed optic holder with the new holder containing the appropriate filter and mirror set.
   Verify that the filters are arranged so that the longest wavelength is in the A position and the shortest wavelength is in the last position used.
4. Close the cytometer side drawer.

More information
• Detector array configurations (page 129)
# Custom configurations and baselines

<table>
<thead>
<tr>
<th>Introduction</th>
<th>This topic describes where to find information on how to create a custom configuration and define a baseline for a performance check.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>BD Cytometer Setup and Tracking (CS&amp;T) software is used to define the baseline performance of your cytometer. A baseline provides a starting point for the tracking of cytometer performance. When running a performance check, you compare the results to the baseline.</td>
</tr>
</tbody>
</table>

Some BP filters might not be normalized to CS&T settings. In this case, CS&T will generate sensitivity and background values (Qr and Br, respectively) that are not comparable from instrument to instrument. They are however, still trackable on one cytometer. In addition, you must carefully check the PMT voltages that CS&T sets for these filters. See Optimizing cytometer settings (page 63). Please see the latest published filter guides available on our website (bdbiosciences.com) for more information.

See the *BD Cytometer Setup and Tracking Application Guide* for information on creating custom configurations and defining a baseline.

| More information | • Running a performance check (page 68) |
This page intentionally left blank
This chapter covers the following topics:

- Maintenance overview (page 46)
- Cleaning the fluidics (page 47)
- Shutting down the cytometer (page 49)
- Flushing the system (page 50)
- Maintaining the waste management system (page 53)
- Replacing the waste air filter (page 56)
- Changing the sheath filter (page 57)
- Changing the Bal seal (page 59)
- Changing the sample tube O-ring (page 61)
Maintenance overview

Introduction
This topic provides an overview of the special order BD LSRFortessa X-20 cell analyzer routine maintenance and cleaning procedures.

General use guidelines

Caution: Biohazard! Coming into contact with all biological specimens and materials is considered biohazardous.

Follow these guidelines whenever operating or maintaining the cytometer:

- Handle all biological specimens and materials as if they are capable of transmitting disease.
- Dispose of waste using proper precautions and in accordance with local regulations.
- Never pipette by mouth.
- Wear suitable protective clothing, eyewear, and gloves.

For fluidics maintenance, we recommend the following cleaning solutions: BD®

- BD® FACSClean solution
- 10% bleach solution
- 0.5% solution of sodium hypochlorite

Use DI water to dilute bleach and sodium hypochlorite to appropriate concentrations.

Caution! Higher concentrations of sodium hypochlorite and use of other cleaning solutions might damage the cytometer.
Perform maintenance procedures in the following frequencies.

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Maintenance procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>• Cleaning the fluidics (page 47)</td>
</tr>
<tr>
<td></td>
<td>• Shutting down the cytometer (page 49)</td>
</tr>
<tr>
<td>Scheduled (every two weeks)</td>
<td>• Flushing the system (page 50)</td>
</tr>
<tr>
<td></td>
<td>• Maintaining the waste management system (page 53)</td>
</tr>
<tr>
<td>Periodic (frequency depends on how often you run the cytometer)</td>
<td>• Changing the sheath filter (page 57)</td>
</tr>
<tr>
<td></td>
<td>• Changing the Bal seal (page 59)</td>
</tr>
<tr>
<td></td>
<td>• Changing the sample tube O-ring (page 61)</td>
</tr>
</tbody>
</table>

**Cleaning the fluidics**

**Introduction**

This topic describes how to perform the daily fluidics cleaning.

**Overview**

Cleaning the fluidics daily prevents the sample injection tube from becoming clogged and removes dyes that can remain in the tubing.

In addition to daily cleaning, follow this procedure immediately after running viscous samples or nucleic acid dyes such as Hoechst, DAPI, propidium iodide (PI), acridine orange (AO), or thiazole orange (TO).

**Procedure**

To clean the fluidics:

1. Press RUN and HIGH on the cytometer fluid control panel.

2. Install a tube containing 3 mL of a cleaning solution on the SIP with the support arm to the side (vacuum on) and let it run for 1 minute.
For the cleaning solution, use BD FACSClean solution. See Maintenance overview (page 46) for other recommended cleaning solutions.

3. Move the tube support arm under the tube (vacuum off) and allow the cleaning solution to run for 5 minutes with the sample flow rate set to HIGH.

4. Repeat steps 2 and 3 with DI water.

5. Repeat steps 2 and 3 with 1.5% dilution of BD Detergent Solution Concentrate.

   Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

   Caution! Do not mix BD Detergent Solution Concentrate and bleach because they produce chlorine gas.

6. Repeat steps 2 and 3 with DI water.

7. Press the STANDBY button on the fluidics control panel.

8. Place a tube containing no more than 1 mL of DI water on the SIP.

   A tube with 1 mL of DI water should remain on the SIP to prevent salt deposits from forming in the injection tube. This tube also catches back drips from the flow cell.

   Caution! Do not leave more than 1 mL of water on the SIP. When the instrument is turned off or left in standby mode, a small amount of fluid will drip back into the sample tube. If there is too much fluid in the tube, it could overflow and affect the cytometer performance.
# Shutting down the cytometer

**Introduction**

This topic describes how to shut down the cytometer.

**Before you begin**

Each time you shut down the cytometer, perform the daily cleaning as described in [Cleaning the fluidics (page 47)](#).

**Procedure**

To shut down the cytometer:

1. Place a tube of DI water on the SIP.
2. Turn off the flow cytometer.
3. Select **Start > Shutdown** to turn off the computer (if needed).
4. If your system is using the BD FACSFlow supply system, shut off the BD FACSFlow supply system.

If the cytometer will not be used for a week or longer, perform a system flush and leave the fluidics system filled with DI water to prevent saline crystals from clogging the fluidics.

**More information**

- [Cleaning the fluidics (page 47)](#)
- [Flushing the system (page 50)](#)
**Flushing the system**

**Introduction**  
This topic describes how to perform an overall fluidics cleaning to remove debris and contaminants from the sheath tubing, waste tubing, and flow cell. Perform the system flush at least every 2 weeks.

*Note:* If you are using the BD FACSFlow supply system, see the *BD FACSFlow Supply System User's Guide* for instructions on flushing the system.

**Cautions**

- **Caution: Biohazard!** The cytometer hardware might be contaminated with biohazardous material. Use 10% bleach to decontaminate the instrument.

**Procedure**  
To perform a system flush:

1. Remove the sheath filter.
   a. Press the quick-disconnects on both sides of the filter assembly.
   b. Remove the filter assembly.
   c. Connect the two fluid lines.

   **Caution!** Do not run detergent, bleach, or ethanol through the sheath filter. They can break down the filter paper within the filter body, causing particles to escape into the sheath fluid, possibly clogging the flow cell.

2. Empty the sheath container and rinse it with DI water.

3. Fill the sheath container with at least 1 L of undiluted BD FACSClean solution.

4. Empty the waste container, if needed.

5. Open the roller clamp by the fluidics interconnect, and drain the fluid into a beaker for 5 seconds.
6. Remove the DI water tube from the SIP.

7. Prime the instrument twice:
   a. Press the PRIME button on the fluidics control panel.
   b. When the STANDBY button lights (amber), press the PRIME button again.

8. Install a tube with 3 mL of undiluted BD FACSClean solution on the SIP and put the tube support arm underneath the tube.
   See Maintenance overview (page 46) for other recommended cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel. Run for 30 minutes.

10. Press the STANDBY fluid control button and depressurize the sheath container by lifting the vent valve.

11. Empty the waste tank to avoid the mixing of Bleach and BD Detergent Solution Concentrate.

12. Repeat steps 2 through 11 with DI water.

13. Repeat steps 2 through 11 with 1.5% dilution of BD Detergent Solution Concentrate.

   Note: The BD Detergent Solution Concentrate must be diluted before use. Mix one full 15 mL bottle of BD Detergent Solution Concentrate into 985 mL of DI water to make 1 L total.

   Caution! Do not mix BD Detergent Solution Concentrate and bleach because they produce chlorine gas.

14. Repeat steps 2 through 11 with DI water.

15. Replace the sheath filter and refill the sheath container with sheath fluid.
| **Next step** | Test the waste management system battery as described in *Maintaining the waste management system* (page 53). |
# Maintaining the waste management system

**Introduction**  
This topic describes how to maintain the waste management system. The waste management system has an alarm powered by a 9-volt battery that you must test and change regularly to ensure continued operation.

<table>
<thead>
<tr>
<th>When to perform the battery test</th>
<th>Test the battery every two weeks after you flush the system. Change the battery as needed.</th>
</tr>
</thead>
</table>
| Testing the battery and alarm    | To test the battery and alarm:  
1. Locate the Battery Test switch on the waste container bracket.  
2. Toggle the switch.  
   If the battery and the alarm are working properly, you should hear an alarm buzzing. If you do not hear any sound, change the battery as described in the following section.  
3. Release the switch. |

![Battery Test Switch](image-url)
Changing the battery

You need the following supplies to change the battery:

- Small flat-head screwdriver
- A 9-volt battery

To change the battery:

1. Insert the tip of a flat-head screwdriver into the slot and gently slide the battery drawer out.

2. Remove the drawer.
3. Remove the battery from the drawer.

4. Place a new 9-volt battery into the drawer.
   The markings in the battery drawer show the correct battery orientation.

5. Slide the drawer into the bracket until you feel a click.

6. Test the new battery.
Replacing the waste air filter

Introduction

This topic describes how to replace the waste air filter. An air filter is located on the cap assembly of the waste container.

Procedure

Caution: Biohazard! Treat a contaminated air filter as biohazardous waste.

To replace the air filter:
1. Remove the air filter.
   Hold the silicone tubing with one hand and pull off the filter with the other hand.
2. Insert a new air filter into the silicone tubing.
3. Verify that the cap assembly on the container is tightened.
Changing the sheath filter

**Introduction**
This topic describes how to change the sheath filter. The sheath filter is connected in-line with the sheath line. It filters the sheath fluid as it comes from the sheath container.

**When to change the sheath filter**
We recommend changing the sheath filter assembly every six months. Increased debris appearing in an FSC vs SSC plot can indicate that the sheath filter needs to be replaced. See Supplies and consumables (page 175) for ordering information.

**Sheath filter components**

![Sheath filter diagram]
- Sheath line
- Quick-disconnect
- Vent fitting
- Vent line
- Filter base
Removing the old filter

To remove the old filter:
1. Place the cytometer in standby mode.
2. Remove the sheath filter assembly by pressing the quick-disconnect on both sides of the filter assembly.
3. Over a sink or beaker:
   - Remove the vent line from the filter and set it aside.
   - Remove the filter base and set it aside.
4. Discard the used filter assembly in an appropriate receptacle.

Attaching the new filter

To attach the new filter:
1. Connect the vent line to the new filter assembly.
   Twist to attach.
2. Wrap Teflon® tape around the filter threads, then connect the filter to the filter base.
3. Connect the sheath line to the filter assembly by squeezing the quick-disconnect.
4. Attach the cytometer fluid line to the filter assembly via the quick-disconnect.
5. Direct the vent line into a beaker and press the small button at the end of the vent fitting against the side of the beaker until a steady stream of fluid empties from the filter.
6. Tilt the filter and verify that no trapped air remains in the filter.
7. Repeat steps 5 and 6 as necessary to remove all trapped air.
Changing the Bal seal

Introduction

This topic describes how to replace the Bal seal.

The sample injection tube Bal seal is a ring that forms a seal with the sample tube and ensures proper tube pressurization.

When to change the Bal seal

Over time, the Bal seal becomes worn or cracked and requires replacement. Replacement is necessary if a proper seal is not formed when a sample tube is installed on the SIP. Indications that a proper seal has not formed include:

- The tube will not stay on the SIP without the tube support arm.
- When the tube is installed and RUN is pressed on the cytometer, the RUN button is orange (not green).

Procedure

To replace the Bal seal:

1. Remove the outer sleeve from the sample injection tube by turning the retainer counter-clockwise. Slide the outer sleeve down and off of the sample injection tube.

Work carefully. The outer sleeve can fall off as you loosen the retainer.
2. Remove the Bal seal by gripping it between your thumb and index finger and pulling down.

3. Install the new Bal seal spring-side up.

   Ensure that the sample tube O-ring is still in place inside the retainer.

4. Re-install the retainer and outer sleeve over the sample injection tube. Push the outer sleeve all the way up into the sample injection port and then screw the retainer into place and tighten to finger tight. This will seat the Bal seal.

5. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.

   If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will go. Tighten the retainer.
## Changing the sample tube O-ring

<table>
<thead>
<tr>
<th><strong>Introduction</strong></th>
<th>This topic describes how to replace the sample tube O-ring. The sample tube O-ring, located within the retainer, forms a seal that allows the droplet containment vacuum to function properly.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>When to replace the O-ring</strong></td>
<td>Replace the O-ring when droplets form at the end of the sample injection tube while the vacuum is operating.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td><strong>Caution: Biohazard!</strong> Cytometer hardware might be contaminated with biohazardous material. Wear suitable protective clothing, eyewear, and gloves whenever cleaning the cytometer or replacing parts.</td>
</tr>
</tbody>
</table>
| **Procedure** | To change the O-ring:  
1. Remove the outer sleeve from the sample injection tube by turning the retainer counter-clockwise.  
2. Slide the outer sleeve from the retainer. |
3. Invert the outer droplet sleeve and allow the O-ring to fall onto the benchtop.
   
   If the O-ring does not fall out initially, hold the O-ring with your free hand and slide the outer sleeve to remove the O-ring.

4. Place the new O-ring into the retainer. Make sure the O-ring is seated properly in the bottom of the retainer.

5. Replace the outer sleeve in the retainer.

6. Re-install the retainer and the outer sleeve.

7. Install a sample tube on the SIP to ensure that the outer sleeve has been properly installed.
   
   If the sleeve hits the bottom of the tube, loosen the retainer slightly and push the sleeve up as far as it will go. Tighten the retainer.
Optimizing cytometer settings

This chapter covers the following topics:

- Cytometer settings workflow (page 64)
- Verifying the configuration and user preferences (page 66)
- Running a performance check (page 68)
- Setting up an experiment (page 72)
- Creating application settings (page 76)
- Recording compensation controls (page 79)
- Calculating compensation (page 82)
Cytometer settings workflow

Introduction

This topic describes how to optimize cytometer settings. The optimization is performed using the Cytometer Setup and Tracking, Application Settings, and Compensation Setup features of BD FACSDiva software.

When to optimize settings

Before you record data for a sample, optimize the cytometer settings for the sample type and fluorochromes used.

Manual compensation

Compensation setup automatically calculates compensation settings. If you choose to perform compensation manually, not all of the following instructions apply. For detailed instructions, see the BD FACSDiva Software Reference Manual.

First-time users

If you are performing the procedures in this workflow for the first time, you should be familiar with BD FACSDiva software concepts: workspace components, cytometer and acquisition controls, and tools for data analysis.

For additional details, see the BD FACSDiva Software Reference Manual.

Before you begin

Start the special order BD LSRFortessa X-20 cell analyzer and perform the setup and QC procedures. See Cytometer setup (page 29).

Workflow for optimizing settings

Cytometer optimization consists of the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verifying the configuration and user preferences (page 66)</td>
</tr>
<tr>
<td>2</td>
<td>Running a performance check (page 68)</td>
</tr>
<tr>
<td>3</td>
<td>Setting up an experiment (page 72)</td>
</tr>
</tbody>
</table>
### About the examples

The examples in this chapter use a 4-color bead sample with the following fluorochromes:

- FITC
- PE
- PerCP-Cy™5.5
- APC

If you follow this workflow with a different bead sample (or another sample type), your software views, data plots, and statistics might differ from the example. Additionally, you might need to modify some of the instructions in the procedure.

The information shown in italics is for example only. You can substitute your own names for folders and experiments.

---

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Creating application settings (page 76)</td>
</tr>
<tr>
<td>5</td>
<td>Recording compensation controls (page 79)</td>
</tr>
<tr>
<td>6</td>
<td>Calculating compensation (page 82)</td>
</tr>
</tbody>
</table>

**Note:** Application settings are optional and do not have to be saved for the experiments. However, they are useful for optimizing cytometer settings.
Verifying the configuration and user preferences

Introduction  This topic describes how to verify the cytometer configuration and user preferences before you create an experiment.

Caution!  To obtain accurate data results, the current cytometer configuration must reflect your BD LSRFortessa X-20 cell analyzer optics.

Procedure  To verify the configuration and preferences before you create an experiment:

1. Select Cytometer > View Configurations and verify the current configuration.

Your cytometer might include only the base configuration when your cytometer is installed. You can create additional configurations later as needed.

In this example, the cytometer configuration must include the following parameters: FITC, PE, PerCP-Cy5.5, and APC.
2. If you need to select a configuration other than the current configuration:
   a. In the Configurations tab, select a configuration.
   b. Click Set Configuration.
   c. Click OK.
   d. Verify that the configuration you just set matches your BD LSRFortessa X-20 cell analyzer optics.

3. Click OK to close the Cytometer Configuration window.

4. Select File > Exit to close CS&T.

5. Select Edit > User Preferences.

6. Click the General tab and select the Load data after recording checkbox.

See the BD FACSDiva Software Reference Manual for more information about cytometer configurations and user preferences.

---

**Next step**

Running a performance check (page 68)

**More information**

- Setting up an experiment (page 72)
# Running a performance check

<table>
<thead>
<tr>
<th><strong>Introduction</strong></th>
<th>This topic describes how to run a performance check as part of quality control.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
<td>The CS&amp;T application is designed to monitor performance on a daily basis and to optimize laser delay. Running a performance check on a regular basis provides a standard for monitoring changes in performance due to degradation of laser power, aging of PMTs, and other potential cytometer service issues. Performance results are also affected by fluidics performance. We strongly recommend following the fluidics maintenance procedures as described in Cleaning the fluidics (page 47).</td>
</tr>
<tr>
<td><strong>Considerations</strong></td>
<td>Some BP filters might not be normalized to CS&amp;T settings. In this case, CS&amp;T will generate Qr and Br numbers that are not comparable from instrument to instrument. They are however, still trackable on one cytometer. Part of the process for optimizing cytometer settings includes verifying PMT voltages set by CS&amp;T for all parameters. Carefully examine any channel with a non-CS&amp;T normalized filter.</td>
</tr>
<tr>
<td><strong>Before you begin</strong></td>
<td>Define the performance baseline for any configuration before running a performance check. See Custom configurations and baselines (page 43).</td>
</tr>
</tbody>
</table>
To run a performance check:

1. Select Cytometer > CST.

2. Verify that the bead lot information under Setup Beads matches the Cytometer Setup and Tracking bead lot.

![Setup Beads]

<table>
<thead>
<tr>
<th>Lot ID:</th>
<th>54102</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product:</td>
<td>CST Setup Beads</td>
</tr>
<tr>
<td>Part #:</td>
<td>910723</td>
</tr>
<tr>
<td>Expiration Date:</td>
<td>09-30-2011</td>
</tr>
</tbody>
</table>

3. Verify that the cytometer configuration is correct for your experiment.

![System Summary]

System Summary: OK

Cytometer Configuration: Custom Blue 4-Red 6-Violet 2-UV
Lot ID: 54102

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control window.

b. Select the correct configuration from the list.

c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline defined.

If not, see the BD Cytometer Setup and Tracking Application Guide for more information on defining a baseline.

5. Prepare the CS&T beads according to the technical data sheet provided with the beads or available on the BD Biosciences website (bdbiosciences.com).
6. Install the bead tube onto the SIP.

7. In the **Setup Control** window, select **Check Performance** from the **Characterize** menu.

8. Click **Run**.

9. Ensure that the SAMPLE FINE ADJ knob is set to the midpoint and press RUN and LOW.

   Plots appear under the Setup tab and the performance check is run. The performance check takes approximately 5 minutes to complete.

10. Once the performance check is complete, click **View Report**.

11. Verify that the cytometer performance passed.

   In the Setup tab, the cytometer performance results should have a green checkbox displayed and the word *Passed* next to it.

If any parameters did not pass, see the *BD Cytometer Setup and Tracking Application Guide* for troubleshooting information.
12. Select **File > Exit** to close the CS&T window and return to the BD FACSDiva interface.

The CST Mismatch dialog opens.

![CST Mismatch dialog](image)

Click the **Details** button to verify which cytometer settings will be updated.

13. Click **Use CST Settings**.

By selecting Use CST Settings, the laser delay, area scaling, and other cytometer settings will be updated to the latest settings from the performance check.

**Next step**

Continue the optimization of your cytometer for an experiment or sample type as described in **Setting up an experiment (page 72)**.
Setting up an experiment

Introduction
This topic describes how to create an experiment in a new folder, specify the parameters of the experiment, and add compensation tubes.

Creating an experiment
To create an experiment:
1. Click the buttons on the Workspace toolbar to display the following windows as needed:
   - Browser
   - Cytometer
   - Inspector
   - Worksheet
   - Acquisition Dashboard
   When you add elements or make selections in the Browser, the Inspector displays details, properties, and options that correspond to your selection.

2. Click the New Folder button on the Browser toolbar to add a new folder.

3. Click the folder and rename it MyFolder.

4. Click MyFolder, then click the New Experiment button on the Browser toolbar.

a. Click the new experiment in the Browser and rename it MyExperiment.
5. Select *MyExperiment* in the **Browser**.

The Inspector displays details for the experiment.

To specify the parameters for the new experiment:

1. Select **Cytometer Settings** for the experiment in the **Browser**.

   Cytometer settings appear in the **Inspector**.

2. Make sure the parameters you need appear on the **Parameters** tab in the **Inspector**.

If more than one parameter is available for a particular PMT, you might have to select the one you need from a menu. For example, you can set Detector F for the blue laser as FITC or Alexa Fluor™ 488.
a. Click the **Parameter** name to display the available fluorochromes in the **Parameters** list.

![Parameter selection](image1)

b. Select the specific parameter from the menu. Your selection appears as the selected parameter.

![Parameter selection](image2)

c. For this example, select **FITC** from the menu.

3. Delete any unnecessary parameters.
a. Click the selection button (to the left of the parameter name) to select the parameter.

b. Click Delete.

The parameter is deleted.
Creating application settings

Introduction

This topic describes how to create application settings.

About application settings

Application settings are associated with a cytometer configuration and include the parameters for the application, area scaling values, PMT voltages, and threshold values, but not compensation. Each time a performance check is run for a configuration, the application settings associated with that configuration are updated to the latest run.

Using application settings provides a consistent and reproducible way to reuse cytometer settings for commonly used applications.

You can include area scaling adjustment in your application settings. See Adjusting area scaling (page 169) for more information.

Before you begin

Perform the cytometer setup procedure and run a performance check for the configuration that will be used for the application.

Procedure

To create application settings:

1. In the open experiment, right-click Cytometer Settings in the Browser, then select Application Settings > Create Worksheet.

   A second global worksheet is added with the plots created according to the selections in the Parameters tab.
2. Load the unstained control tube onto the cytometer.

3. In the Cytometer window, optimize the PMT voltages for the application.
   - Optimize the FSC and SSC voltages to place the population of interest on scale.
   - Optimize the FSC threshold value to eliminate debris without interfering with the population of interest.
   - If needed, increase the fluorescence PMT voltages to place the negative population within the gray boxes. Align the center of the negative population with the crosshair visible in the gray box.

   **Note:** Do not decrease the fluorescence PMT voltages. Doing so can make it difficult to resolve dim populations from the negative population.

4. Unload the unstained control tube from the cytometer.

5. Load the multicolor sample onto the cytometer or load single-color control tubes and verify each fluorochrome signal separately.
6. Verify that the positive populations are on scale.
   If a positive population is off scale, lower the PMT voltage for that parameter until the positive population can be seen entirely on scale.

7. Unload the multicolor sample.

8. Place a tube containing DI water on the SIP and put the cytometer on standby.

9. (Optional) Save the application settings by right-clicking Cytometer settings in the Browser, then selecting Application Settings > Save.

10. In the Save Application Settings dialog, enter a descriptive name for the application settings.

11. Click OK.

    The application settings are saved to the catalog.

---

**Next step**

Recording compensation controls (page 79)
Recording compensation controls

Introduction

This topic describes how to create and record compensation controls using the Compensation Setup feature of BD FACSDiva software and an experiment with optimized settings.

Creating compensation tubes

To create compensation control tubes:

1. Select Experiment > Compensation Setup > Create Compensation Controls.

   The Create Compensation Controls dialog opens.

   For this bead example, you do not need to provide non-generic tube labels.

2. Click OK.
Compensation control tubes are added to the experiment. Worksheets containing appropriate plots and gates are added for each compensation tube.

To record compensation settings:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the unstained control tube onto the SIP.
3. Expand the Compensation Controls specimen in the Browser.
4. Set the current tube pointer to the unstained control tube (it becomes green), then click Acquire Data in the Acquisition Dashboard.
5. Verify that the population of interest is displayed appropriately on the FSC vs SSC plot and adjust voltages if necessary.
Since the application settings have been optimized for your sample, the cytometer settings should not require adjustment other than the changing of FSC and SSC voltages to place the beads on scale.

6. Adjust the P1 gate to surround only the singlets.

7. Right-click the P1 gate and select **Apply to All Compensation Controls**.

   The P1 gate on each stained control worksheet is updated with your changes.

8. Click **Record Data**.

9. When recording is finished, remove the unstained control tube from the cytometer.

10. Click **Next Tube**.

   **Caution!** Do not change the PMT voltages after the first compensation control has been recorded. In order to calculate compensation, all controls must be recorded with the same PMT voltage settings. If you need to adjust the PMT voltage for a subsequent compensation control, you must record all compensation controls again.

11. Install the next tube onto the cytometer and repeat steps 8 through 10 until data for all stained control tubes has been recorded.

12. Double-click the first stained control tube to display the corresponding worksheet.
13. Verify that the snap-to interval gate encompasses the positive population.

14. Repeat steps 12 and 13 for the remaining compensation tubes.

---

**Next step**

After you have recorded data for each single-stained control, calculate compensation as described in Calculating compensation (page 82).

---

**Calculating compensation**

**Introduction**

This topic describes how to calculate compensation.

**Before you begin**

Before you can calculate compensation, you need to record the data for each single-stained control.

**Procedure**

To calculate compensation:

1. Select Experiment > Compensation Setup > Calculate Compensation.

   **Note:** If the calculation is successful, a dialog prompts you to enter a name for the compensation setup. The default name is year/month/day/time.
2. Enter a setup name and click **Link & Save**.

   The compensation is linked to the cytometer settings and saved to the catalog.

   To help track compensation setups, include the experiment name, date, or both in the setup name.

   The compensation setup is linked to the *MyExperiment* cytometer settings, and subsequent acquisitions in *MyExperiment* are performed with the new compensation settings.

   We recommend that you always visually and statistically inspect automatically calculated spectral overlap values. The means of the positive controls should be aligned with the means of the negative controls.

---

**More information**

- Recording compensation controls (page 79)
This chapter covers the following topics:

- Data recording and analysis workflow (page 86)
- Preparing the workspace (page 87)
- Recording data (page 88)
- Analyzing data (page 91)
- Reusing an analysis (page 97)
Data recording and analysis workflow

Introduction
This topic outlines the basic acquisition and analysis tasks using BD FACSDiva software.

About the examples
The examples in this chapter are from two 4-color bead samples with the following fluorochromes:

- FITC
- PE
- PerCP-Cy5.5
- APC

If you use a different sample type or if you have skipped the optimization steps in Optimizing cytometer settings (page 63), your software window content, names of folders and experiments, and your data plots and statistics might differ from those shown here. You might also need to modify some of the instructions in the procedure.

For additional details on completing some of the following steps, see the BD FACSDiva Software Reference Manual.

This procedure builds on the results obtained in Optimizing cytometer settings (page 63).

Workflow for recording and analyzing data
Recording and analyzing data consists of the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Preparing the workspace (page 87)</td>
</tr>
<tr>
<td>2</td>
<td>Recording data (page 88)</td>
</tr>
<tr>
<td>3</td>
<td>Analyzing data (page 91)</td>
</tr>
<tr>
<td>4</td>
<td>Reusing an analysis (page 97)</td>
</tr>
</tbody>
</table>
Preparing the workspace

Introduction
This topic describes how to prepare the workspace and apply application settings to your experiment before recording data.

Procedure
To prepare the workspace:
1. Using the Browser toolbar, create a new specimen in MyExperiment and rename it FourColorBeads.
2. Create two tubes for the FourColorBeads specimen. Rename the tubes Beads_001 and Beads_002.
3. Expand the Global Worksheets folder in MyExperiment to access the default global worksheet, and rename the worksheet MyData.
4. On the MyData worksheet, create the following plots for previewing the data:
   - FSC vs SSC
   - FITC vs PE
   - FITC vs PerCP-Cy5.5
   - FITC vs APC

Applying saved application settings to a new experiment
When applications settings are applied to an experiment, the cytometer settings are updated with the parameters included in the application settings, optimized PMT voltages, threshold settings, area scaling factors, and window extension values.

To apply saved application settings to your experiment:
1. Right-click the experiment-level Cytometer Settings and select Application Settings > Apply.
2. In the Application Settings catalog, select the application settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens.

- Click Overwrite to update all settings.
- Click Apply to change only the common parameters.

For more information, see the BD FACS Diva Software Reference Manual.

The cytometer settings are renamed application settings and the cytometer settings icon in the Browser changes.

More information
- Creating application settings (page 76)
- Recording data (page 88)

Recording data

Introduction
This topic provides an example of how to preview and record data for multiple samples.

Before you begin
Prepare the sample tubes.

Recording data
To record data:
1. Press RUN and HIGH on the cytometer fluid control panel.
2. Install the first sample tube onto the SIP.
3. Set the current tube pointer to Beads_001.
4. Click Acquire Data in the Acquisition Dashboard to begin acquisition.
5. While data is being acquired:
   a. Draw a gate around the singlets on the FSC vs SSC plot.
   b. Rename the P1 gate to *Singlets*.
   c. Use the **Inspector** to set the other plots to show only the singlet population by selecting the Singlets checkbox.

6. Click **Record Data**.

7. When event recording has completed, remove the first tube from the cytometer.

The *MyData* worksheet plots should look like the following.
8. Install the second sample tube onto the SIP.

9. Set the current tube pointer to Beads_002.

10. Click Acquire Data to begin acquisition.

11. Before recording, preview the data on the MyData worksheet to verify that all expected populations are visible and the data is similar to the previous sample.

12. Click Record Data.

13. When event recording has completed, remove the second tube from the cytometer.

14. If you are recording more than two tubes, repeat steps 8 through 13 for the remaining tubes.

15. Print the experiment-level cytometer settings by right-clicking the Cytometer Settings icon in the Browser and selecting Print.

16. Install a tube of DI water onto the SIP.

17. Place the cytometer in standby mode.

More information

- Analyzing data (page 91)
Analyzing data

Introduction
This topic describes how to analyze recorded tubes by creating plots, gates, a population hierarchy, and statistics views on a new global worksheet.

Analyzing data
To analyze data:

1. Use the Browser toolbar to create a new global worksheet. Rename it MyDataAnalysis.

2. Create the following plots on the MyDataAnalysis worksheet:
   - FSC vs SSC
   - FITC vs PE
   - FITC vs PerCP-Cy5.5
   - FITC vs APC

3. Create a population hierarchy and a statistics view, and set them below the plots on the worksheet.
   - Right-click any plot and select Show Population Hierarchy.
   - Right-click any plot and select Create Statistics View.

4. Set the current tube pointer to Beads_001.

5. Draw a gate around the singlets on the FSC vs SSC plot.

6. Use the population hierarchy to rename the population Singlets.
7. Select all plots except the FSC vs SSC plot, and use the Plot tab in the Inspector to specify to show only the singlet population.

8. Select all plots, and click the Title tab in the Inspector.
9. Select the Tube and Populations checkboxes to display their names in plot titles.

10. On all fluorescence plots:
   - Make all plots biexponential. Select all fluorescence plots and select the X Axis and Y Axis checkboxes in the Plot tab of the Inspector.
• In the FITC vs PE plot, draw a gate around the FITC-positive population. Name the population *FITC positive* in the population hierarchy.

• In the FITC vs PE plot, draw a gate around the PE-positive population. Name the population *PE positive* in the population hierarchy.

• In the FITC vs PerCP-Cy5.5 plot, draw a gate around the PerCP-Cy5.5-positive population. Name the population *PerCP-Cy5.5 positive* in the population hierarchy.

• In the FITC vs APC plot, draw a gate around the APC-positive population. Name the population *APC positive* in the population hierarchy.

11. Format the statistics view.

   a. Right-click the statistics view and select *Edit Statistics View*.

   b. Click the *Header* tab and select the *Specimen Name* and *Tube Name* checkboxes.

   c. Click the *Populations* tab and select all populations except *All Events*. Clear the *%Parent*, *%Total*, and *#Events* checkboxes.

   d. Click the *Statistics* tab and select the mean for each of the fluorescence parameters.
e. Click **OK**.

12. Print the analysis.
Your global worksheet analysis objects should look like the following.
Reusing an analysis

Introduction
This topic describes how to use a global worksheets to apply the same analysis to a series of recorded tubes. Once you define an analysis for a tube, you can use it to analyze the remaining tubes in the experiment. After viewing the data, print the analysis or save it to a normal worksheet.

Reusing an analysis
To reuse the analysis:
1. Set the current tube pointer to the Beads_002 tube.
2. View the Beads_002 data on your analysis worksheet. Adjust the gates as needed.
   Adjustments apply to subsequent tubes viewed on the worksheet. To avoid altering a global worksheet, save an analysis to a normal worksheet, then make adjustments on the normal worksheet.
3. Print the analysis.

Saving the analysis
When you perform analysis with a global worksheet, the analysis does not save with the tube.

If you define your analysis on a global worksheet before recording data, you can specify to automatically save the analysis after recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:
1. Expand the MyDataAnalysis global worksheet icon in the Browser.
2. Right-click its analysis and select Copy.

3. Click the Worksheets View button on the Worksheet toolbar to switch to the normal worksheet view.

4. Select Worksheet > New Worksheet to create a new normal worksheet.

5. Right-click the Beads_001 tube icon in the Browser, and select Paste.

   The analysis objects from the MyDataAnalysis global worksheet are copied to the Beads_001_Analysis normal worksheet. Double-click the Beads_001 tube in the Browser to view the analysis.

---

**Applying an analysis to normal worksheets**

You can apply the global worksheet analysis to multiple tubes (on a single normal worksheet) by selecting multiple tubes before pasting the analysis. Ensure that you collapse all tube elements in the Browser before you paste them to multiple tubes.

**More information**

- Analyzing data (page 91)
This chapter provides a technical overview of the following topics:

- About fluidics (page 100)
- About optics (page 101)
- About electronics (page 112)
About fluidics

Introduction

This topic describes the fluidics system in the special order BD LSRFortessa X-20 cell analyzer.

Pressure-driven fluidics system

The fluidics system in the BD LSRFortessa X-20 cell analyzer is pressure-driven. A built-in air pump provides a sheath pressure of 5.5 psi. After passing through the sheath filter, sheath fluid is introduced into the lower chamber of the quartz flow cell.

Hydrodynamic focusing

The sample to be analyzed arrives in a separate pressurized stream. When a sample tube is placed on the SIP, the sample is forced up and injected into the lower chamber of the flow cell by a slight overpressure relative to the sheath fluid. The conical shape of the lower chamber creates a laminar sheath flow that carries the sample core upward through the center of the flow cell, where the particles to be measured are intercepted by the laser beam. This process is known as hydrodynamic focusing.

The objective in flow cytometric analysis is to have at most one cell or particle moving through a laser beam at a given time. The difference in pressure between the sample stream and sheath fluid stream can be used to vary the diameter of the sample core.
Increasing the sample pressure increases the sample flow rate thereby increasing the core diameter. The flow rate should be set according to the type of application you are running.

- A higher flow rate is generally used for qualitative measurements such as immunophenotyping. The data is less resolved, but is acquired more quickly.
- A lower flow rate is generally used in applications where greater resolution and quantitative measurements are critical, such as DNA analysis.

Proper operation of fluidic components is critical for particles to intercept the laser beam properly. Always ensure that the fluidics system is free of air bubbles and debris, and is properly pressurized.

---

### About optics

**Introduction**

This topic describes the optics system and provides information about:

- Light scatter (page 102)
- Fluorescence (page 102)
- Optical filter theory (page 104)
- Compensation theory (page 109)

**Optics system**

The optics system consists of lasers, optical filters, and detectors. Lasers illuminate the cells or particles in the sample and optical filters direct the resulting light scatter and fluorescence signals to the appropriate detectors.
Light scatter

When a cell or particle passes through a focused laser beam, laser light is scattered in all directions. Light that scatters axial to the laser beam is called forward scatter (FSC) and light that scatters perpendicular to the laser beam is called side scatter (SSC).

FSC and SSC are related to certain physical properties of cells.

- **FSC.** Indicates relative differences in the size of the cells or particles. Larger cells scatter more light and therefore they are higher in FSC.
- **SSC.** Indicates relative differences in the internal complexity or granularity of the cells or particles. More granular cells deflect more light than less granular cells, and therefore are higher in SSC.

Fluorescence

When cells or particles stained with fluorochrome-conjugated antibodies or other dyes pass through a laser beam, the dyes can absorb photons (energy) and be promoted to an excited electronic state. In returning to their ground state, the dyes release energy, most of which is emitted as light. This light emission is known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the excitation wavelength. The difference between the excitation wavelength and the emission wavelength is known as the Stokes shift. Some fluorescent compounds such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and emitting red light (675 nm), while other fluorochromes such as
FITC have a smaller Stokes shift, absorbing blue light (488 nm) and emitting green light (530 nm).

The following figure shows the emission spectra of some commonly used fluorochromes.

![Emission Spectra of Fluorochromes](image)

Actual emission intensity will depend on excitation wavelength. See *Fluorescence spectra* (page 130) for more information on excitation and emission of fluorochromes. An interactive spectral viewer is also available at bdbiosciences.com.
Optical filter theory

Optical filters modify the spectral distribution of light scatter and fluorescence directed to the detectors. When photons encounter an optical filter, they are either transmitted, absorbed, or reflected.

Even though an optical filter is rated at its 50% transmission point, the filter passes (lets through) a minimal amount of light outside of this indicated rating.

The slope of an optical filter transmission curve indicates filter performance. A relatively steep slope indicates a high-performance, high-quality optical filter that provides deep attenuation of out-of-band wavelengths. A less steep slope indicates that more light outside the rated bandwidth is being transmitted.

Types of optical filters

There are four types of filters.

- **Longpass (LP) filters.** Transmit wavelengths that are longer than the specified value.
- **Shortpass (SP) filters.** Transmit wavelengths that are shorter than the specified value. This type of filter is not recommended, but can be used in some custom configurations. See [Shortpass (SP) filters (page 106)](#).
- **Bandpass (BP) filters.** Pass a narrow spectral band of light by combining the characteristics of shortpass filters, longpass filters, and absorbing layers.
• **Notch filters.** Pass all frequencies except those in a stop band centered on a center frequency. They are the opposite of bandpass filters.

The BD LSRFortessa X-20 uses LP filters and BP filters. Notch filters are sometimes used in special order BD LSRFortessa X-20 instruments.

**Longpass (LP) filters**

LP filters pass wavelengths longer than the filter rating. For example, a 500-LP filter permits wavelengths 500 nm or longer to pass through it and either absorbs or reflects wavelengths shorter than 500 nm.
Shortpass (SP) filters

An SP filter has the opposite properties of an LP filter. An SP filter passes light with a shorter wavelength than the filter rating. For example, a 500-SP filter passes wavelengths of 500 nm or shorter, and reflects or absorbs wavelengths longer than 500 nm.
A BP filter transmits a relatively narrow range or band of light. BP filters are typically designated by two numbers. The first number indicates the center wavelength and the second refers to the width of the band of light that is passed. For example, a 500/50-BP filter transmits light that is centered at 500 nm and has a total bandwidth of 50 nm. Therefore, this filter transmits light between 475 and 525 nm.

The performance of an optical BP filter depends on the optical transmission. Sample transmission curves are shown in the following figure. A filter with a narrower (steeper) transmission curve generally yields higher performance. The transmission specifications depend on the construction of the filter.

Higher performance filters generally have multiple layers of optical coatings and unique manufacturing processes. For more demanding multicolor applications, higher performance filters are available through the special order research program. Contact your local BD Biosciences sales representative for details.
Dichroic mirrors

Dichroic filters that are used to direct different color light signals to different detectors are called dichroic mirrors.

Although some of the properties of LP and SP filters are similar to dichroic mirrors (for example, allowing a specific wavelength range to pass), filters and mirrors cannot be used interchangeably, especially if used as dichroic mirrors. A dichroic mirror must have a surface coating that reflects certain wavelengths, but many LP or SP filters are absorbance filters that do not have any specific reflective characteristics. Also, optical filters and dichroic mirrors are rated at a specific angle of incidence. When used in front of the fluorescence detectors, they are perpendicular to the incident light, and when used as a dichroic mirror, they are placed at an angle relative to the light source. Their optical properties are therefore designed for that angle of incidence.
Fluorochromes emit light over a range of wavelengths. Optical filters are used to limit the range of frequencies measured by a given detector. However, when two or more fluorochromes are used, the overlap in wavelength ranges often makes it impossible for optical filters to isolate light from a given fluorochrome. As a result, light emitted from one fluorochrome appears in a detector intended for another. This is referred to as spillover. Spillover can be corrected mathematically by using a method called compensation.

In the following example, FITC emission appears primarily in the FITC detector, but some of its fluorescence spills over into the PE detector. The spillover must be corrected or compensated for. Alternatively, the spillover can be minimized by discrete excitation of fluorochromes. In the following example, excitation with a 561-nm laser (special order) will help minimize spillover.

This spillover can be seen in a dot plot of FITC vs PE. The FITC spillover in the PE detector must be corrected as demonstrated in the two figures that follow.
Using the Compensation tab of the Cytometer window in BD FACSDiva software, you can adjust the PE-%FITC spectral overlap value. Compensation is optimal when the positive and negative FITC populations have the same means in the PE parameter statistics.

The following image shows the FITC spillover optimally compensated out of the PE parameter.

Once fluorescence compensation has been set for any sample, the compensation setting remains valid for a subsequent dim or bright sample (provided the signal is not saturated), because compensation subtracts a percentage of the fluorescence intensity. The following figure illustrates this principle. Although the signals differ in intensity, the percentage of the FITC spillover into the PE detector remains constant.
FITC PE

Different intensity FITC signals

Same proportion or percentage of spectral overlap in PE channel
About electronics

Introduction

This topic describes the electronics in the special order BD LSRFortessa X-20 cell analyzer.

Pulse

As cells or other particles pass through a focused laser beam, they scatter the laser light and can emit fluorescence. Because the laser beam is focused on a small spot and particles move rapidly through the flow cell, the scatter or fluorescence emission signal has a very brief duration—only a few microseconds. This brief flash of light is converted into an electrical signal by the detectors. The electrical signal is called a pulse. The following figures illustrate the anatomy of a pulse.

1. A pulse begins when a particle enters the laser beam. At this point, both the beam intensity and signal intensity are low.

![Diagram of pulse beginning]

2. The pulse reaches a maximum intensity or height when the particle reaches the middle of the beam, where the beam and signal intensity are the brightest. The peak intensity, or height of the pulse, is measured at this point.

![Diagram of pulse reaching maximum intensity]
3. As the particle leaves the beam, the pulse trails off below the threshold.

The pulse processors measure pulses by three characteristics: height, area, and width.

- **Height.** The maximum digitized intensity measured for the pulse.

- **Area.** The integration of all the digitized samples over time, where time is the window gate plus 1/2 the window extension added before the initial threshold, plus the other half of the window extension value added after the pulse drops below the threshold. The window gate extends until the pulse is 75% of the initial threshold.

- **Width.** Calculates: \[ \frac{\text{Area}}{\text{Height}} \times 64,000 \]
**Digital electronics**

BD LSRFortessa X-20 electronics digitize the signal intensity produced by a detector. The digitized data is stored in memory and further processed by the electronics to calculate:

- Pulse height, area, and width
- Compensation
- Parameter ratios

These results are transferred to your workstation computer for further processing by BD FACSDiva software. For more information about digital theory, see Digital Theory in the *BD FACSDiva Software Reference Manual*.

---

**Threshold**

The threshold is the level at which the system starts to measure signal pulses. A threshold is defined for a specific detector signal. The system continuously samples the digitized signal data and calculates pulse area, height, and width for all channels based on the time interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse measures are based on either of the following:

- Intervals during which ALL signals exceed their threshold value (AND threshold in the software)
- Intervals during which ANY signal exceeds its threshold value (OR threshold in the software)
**Laser controls**

Controls in the Laser tab of the Cytometer window are used to manually set the (laser) delay, area scaling, and window extension values.

These parameters are set by BD Biosciences service personnel during instrument installation and performance check and are updated each time you run a performance check.

If needed, see Optimizing laser delay (page 167) for instructions on manually adjusting laser delay settings. Do not otherwise change the settings in the Laser tab unless instructed to do so by BD Biosciences. Changing the settings affects your data.

---

**More information**

- Running a performance check (page 68)
- Optimizing laser delay (page 167)
8

Troubleshooting

This chapter covers the following topics:

- Cytometer troubleshooting (page 118)
- Electronics troubleshooting (page 127)
# Cytometer troubleshooting

## Introduction

This topic describes possible problems and recommended solutions for special order BD LSRFortessa X-20 cell analyzer issues.

## Droplets are visible on the SIP

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worn O-ring in the retainer</td>
<td>Replace the O-ring. See <a href="#change-the-sample-tube-or-ring">Changing the sample tube O-ring</a> (page 60).</td>
</tr>
</tbody>
</table>
| Outer sleeve is not seated in the retainer          | 1. Loosen the retainer.  
2. Push the outer sleeve up into the retainer until seated.  
3. Tighten the retainer. |
| Outer sleeve is not on the sample injection tube    | Replace the outer sleeve.  
1. Loosen the retainer.  
2. Slide the outer sleeve over the sample injection tube until it is seated.  
3. Tighten the retainer. |
| Waste line is pinched, preventing proper aspiration | Check the waste line.                                                                |
| Waste tank is full                                  | Empty the waste tank.                                                                |
| Droplet containment vacuum is not functioning       | Call your BD service representative.                                                 |
| The HTS acquisition control switch is in plate mode | Change the acquisition control switch to tube mode. See the *BD High Throughput Sampler User’s Guide* for more information. |
### Sample tube not fitting on SIP

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample tube other than Falcon® tubes used</td>
<td>Use Falcon 12 x 75-mm sample tubes. See Equipment (page 178).</td>
</tr>
<tr>
<td>Worn Bal seal</td>
<td>Replace the Bal seal. See Changing the Bal seal (page 58).</td>
</tr>
<tr>
<td>Sample tube is cracked</td>
<td>Transfer contents to a new tube.</td>
</tr>
</tbody>
</table>

### Rapid sample aspiration

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support arm is to the side</td>
<td>Place the support arm under the sample tube.</td>
</tr>
<tr>
<td>Droplet containment module is failing</td>
<td>Try the solutions in Droplets are visible on the SIP (page 118). If the issue is not resolved, call your BD service representative.</td>
</tr>
</tbody>
</table>

### No events in acquisition display and RUN button is green

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold is not set to the correct parameter (usually FSC)</td>
<td>Set the threshold to the correct parameter for your application.</td>
</tr>
<tr>
<td>Threshold level is too high</td>
<td>Lower the threshold level.</td>
</tr>
<tr>
<td>PMT voltage for threshold parameter is set too low</td>
<td>Set the PMT voltage higher for the threshold parameter.</td>
</tr>
<tr>
<td>Gating issue</td>
<td>See the BD FACSDiva Software Reference Manual for information on setting gates.</td>
</tr>
<tr>
<td>Air in the sheath filter</td>
<td>Purge the filter. See Removing air bubbles (page 33).</td>
</tr>
<tr>
<td>Air bubble or debris in the flow cell</td>
<td>Prime the fluidics system. See Priming the fluidics (page 39).</td>
</tr>
<tr>
<td>Possible causes</td>
<td>Recommended solutions</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>No sample in the tube</td>
<td>Verify that sample remains in the tube and if necessary, add sample to the tube or install a new sample tube.</td>
</tr>
<tr>
<td>Sample is not mixed properly</td>
<td>Mix the sample to suspend the cells.</td>
</tr>
<tr>
<td>Waste tank is full</td>
<td>Empty the waste tank.</td>
</tr>
<tr>
<td>PMT voltages set too low or too high for display parameter</td>
<td>Adjust the PMT voltages.</td>
</tr>
<tr>
<td>Too few events are displayed</td>
<td>Increase the number of events to display.</td>
</tr>
<tr>
<td>Sample injection tube is clogged</td>
<td>Remove the sample tube to allow backflushing.</td>
</tr>
<tr>
<td></td>
<td>If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics (page 47).</td>
</tr>
<tr>
<td>Bal seal is worn</td>
<td>Replace the Bal seal. See Changing the Bal seal (page 58).</td>
</tr>
<tr>
<td>Instrument is not warmed up</td>
<td>Wait 30 minutes for the instrument to warm up.</td>
</tr>
<tr>
<td>Laser delay is set incorrectly</td>
<td>Adjust the laser delay settings. See Manual settings (page 165).</td>
</tr>
<tr>
<td>Laser is not functioning</td>
<td>Verify the malfunction by changing the threshold to an alternative laser while running the appropriate sample. If unsuccessful, contact BD Biosciences.</td>
</tr>
<tr>
<td>Tube is cracked or misshapen</td>
<td>Replace the sample tube.</td>
</tr>
</tbody>
</table>
### No events in acquisition display and RUN button is orange

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN is not activated</td>
<td>Press the RUN button.</td>
</tr>
<tr>
<td>Sample tube is not installed or is not properly seated</td>
<td>Install the sample tube correctly on the SIP.</td>
</tr>
<tr>
<td>Waste container is pressurized</td>
<td>Replace the waste air filter.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution!</strong> Pressurized contents might spray. Use appropriate cautionary measures.</td>
</tr>
<tr>
<td></td>
<td>1. Slowly loosen the waste tank cap to relieve the pressure in the waste tank.</td>
</tr>
<tr>
<td></td>
<td>2. Remove the waste vent filter by rotating counter-clockwise.</td>
</tr>
<tr>
<td></td>
<td>3. Install a new waste vent filter.</td>
</tr>
<tr>
<td>Sample tube is cracked</td>
<td>Replace the sample tube.</td>
</tr>
<tr>
<td>Waste tubing line is not connected to the waste cap</td>
<td>Connect the waste tubing line to the waste cap.</td>
</tr>
<tr>
<td>Sheath container is not pressurized</td>
<td>• Ensure that the sheath container lid and all connectors are securely seated.</td>
</tr>
<tr>
<td></td>
<td>• Inspect the sheath container O-ring inside the lid and replace it if necessary.</td>
</tr>
<tr>
<td>Bal seal is worn</td>
<td>Replace the Bal seal. See Changing the Bal seal (page 58).</td>
</tr>
<tr>
<td>Air leak at sheath container</td>
<td>Ensure that the sheath container lid and all connectors are securely seated.</td>
</tr>
<tr>
<td>Sheath container is empty</td>
<td>Fill the sheath container.</td>
</tr>
<tr>
<td>Air in sheath filter</td>
<td>Purge the filter. See Removing air bubbles (page 33).</td>
</tr>
</tbody>
</table>
### No fluorescence signal

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incorrect fluorochrome assignment</td>
<td>Make sure that the cytometer configuration in the software matches the optical filters in the cytometer and the configuration is as expected.</td>
</tr>
<tr>
<td>Wrong filter is installed</td>
<td>Make sure the appropriate filter is installed for each fluorochrome. See Changing optical filters and mirrors (page 42).</td>
</tr>
<tr>
<td>Laser is not functioning</td>
<td>Call your BD service representative.</td>
</tr>
</tbody>
</table>

### No signal in red laser channels

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
</table>
| Incorrect laser delays due to a change in the sheath tank fluid level | • Check the fluid level in the sheath tank and refill if necessary.  
  • Adjust the laser delay settings. See Manual settings (page 165). |

### High event rate

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Air bubbles in the sheath filter or flow cell</td>
<td>Remove the air bubbles. See Removing air bubbles (page 33).</td>
</tr>
<tr>
<td>Threshold level is too low</td>
<td>Increase the threshold level. See the BD FACSDiva Software Reference Manual for instructions.</td>
</tr>
</tbody>
</table>
| PMT voltage for the threshold parameter is set too high | Set the PMT voltage lower for the threshold parameter. See the  
| Sample is too concentrated                  | Dilute the sample.                                                                      |
| Sample flow rate is set to HIGH             | Set the sample flow rate to MED or LOW.                                                 |
## Low event rate

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold level is too high</td>
<td>Lower the threshold level. See the <em>BD FACSDiva Software Reference Manual</em> for instructions.</td>
</tr>
<tr>
<td>Air bubble or debris in the flow cell</td>
<td>Prime the fluidics system. See <em>Priming the fluidics</em> (page 39).</td>
</tr>
<tr>
<td>PMT voltage for the threshold parameter is set too low</td>
<td>Set the PMT voltage higher for the threshold parameter. See the <em>BD FACSDiva Software Reference Manual</em> for instructions.</td>
</tr>
<tr>
<td>Sample is not adequately mixed</td>
<td>Mix the sample to suspend the cells.</td>
</tr>
<tr>
<td>Sample is too diluted</td>
<td>Concentrate the sample. If the flow rate setting is not critical to the application, set the flow rate switch to MED or HI.</td>
</tr>
<tr>
<td>Sample injection tube is clogged</td>
<td>Remove the sample tube to allow backflushing. If the event rate is still erratic, clean the sample injection tube. See <em>Cleaning the fluidics</em> (page 47).</td>
</tr>
</tbody>
</table>

## Erratic event rate

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample tube is cracked</td>
<td>Replace the sample tube.</td>
</tr>
<tr>
<td>Air bubble or debris in the flow cell</td>
<td>Prime the fluidics system. See <em>Priming the fluidics</em> (page 39).</td>
</tr>
<tr>
<td>Bal seal is worn</td>
<td>Replace the Bal seal. See <em>Changing the Bal seal</em> (page 58).</td>
</tr>
</tbody>
</table>
### Distorted scatter parameters

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample injection tube is clogged</td>
<td>Remove the sample tube to allow backflushing. If the event rate is still erratic, clean the sample injection tube. See Cleaning the fluidics (page 47).</td>
</tr>
<tr>
<td>Contaminated sample</td>
<td>Prepare the specimen again. Ensure that the tube is clean.</td>
</tr>
<tr>
<td>Sheath filter is dirty</td>
<td>Replace the filter. See Changing the sheath filter (page 56).</td>
</tr>
</tbody>
</table>

### Excessive amount of debris in display

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold level is too low</td>
<td>Increase the threshold level.</td>
</tr>
<tr>
<td>Sheath filter is dirty</td>
<td>Replace the filter. See Changing the sheath filter (page 56).</td>
</tr>
<tr>
<td>Flow cell is dirty</td>
<td>Flush the system. See Flushing the system (page 50).</td>
</tr>
</tbody>
</table>
### High CV or poor QC results

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dead cells or debris in the sample</td>
<td>Examine the sample under a microscope.</td>
</tr>
<tr>
<td>Sample is contaminated</td>
<td>Re-stain the sample. Ensure that the tube is clean.</td>
</tr>
<tr>
<td>Stock sheath fluid is contaminated</td>
<td>Rinse the sheath container with DI water, then fill the container with sheath fluid from another (or new lot) bulk container.</td>
</tr>
<tr>
<td>Air bubble in sheath filter or flow cell</td>
<td>- Purge the filter. See Removing air bubbles (page 33).</td>
</tr>
<tr>
<td></td>
<td>- Prime the fluidics system. See Priming the fluidics (page 39).</td>
</tr>
<tr>
<td>Sample flow rate is set too high</td>
<td>Set the sample flow rate lower.</td>
</tr>
<tr>
<td>Air leak at sheath container</td>
<td>Ensure that the sheath container lid is tight and all connectors are secure.</td>
</tr>
<tr>
<td>Flow cell is dirty</td>
<td>Flush the system. See Flushing the system (page 50).</td>
</tr>
<tr>
<td>The dichroic mirrors are installed backwards</td>
<td>Remove the dichroic mirrors, reverse them, and replace them in the optical holder.</td>
</tr>
<tr>
<td>Possible causes</td>
<td>Recommended solutions</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Waste tank is pressurized</td>
<td>Replace the waste vent filter.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution!</strong> Pressurized contents might spray. Use appropriate cautionary measures.</td>
</tr>
<tr>
<td></td>
<td>1. Slowly loosen the waste tank cap to relieve the pressure in the waste tank.</td>
</tr>
<tr>
<td></td>
<td>2. Remove the waste vent filter by rotating counter-clockwise.</td>
</tr>
<tr>
<td></td>
<td>3. Install a new waste vent filter.</td>
</tr>
<tr>
<td>Poor sample preparation</td>
<td>Repeat sample preparation.</td>
</tr>
<tr>
<td>Sample was not diluted in the same fluid as the sheath fluid</td>
<td>Dilute the sample in the same fluid as you are using for sheath.</td>
</tr>
<tr>
<td>Optical filters are incorrect</td>
<td>Check the configuration and insert the correct filters.</td>
</tr>
<tr>
<td>Old or contaminated QC particles</td>
<td>Make new QC samples and perform the quality control procedure again.</td>
</tr>
<tr>
<td>Instrument is not warmed up</td>
<td>Wait 30 minutes for the instrument to warm up.</td>
</tr>
<tr>
<td>Laser is not functioning</td>
<td>Contact BD Biosciences.</td>
</tr>
<tr>
<td>Optical alignment problem</td>
<td>Contact BD Biosciences.</td>
</tr>
<tr>
<td>Optical filters are incorrect</td>
<td>Check the configuration and insert the correct filters.</td>
</tr>
</tbody>
</table>
## Electronics troubleshooting

### Introduction

This topic describes possible problems and recommended solutions for BD LSRFortessa X-20 electronic issues.

### “Cytometer Disconnected” in cytometer window

<table>
<thead>
<tr>
<th>Possible causes</th>
<th>Recommended solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cytometer power is off</td>
<td>Turn on the cytometer main power.</td>
</tr>
<tr>
<td>Communication failure between workstation and cytometer</td>
<td>1. In BD FACSDiva software, select Cytometer &gt; Connect.</td>
</tr>
<tr>
<td></td>
<td>2. If connecting does not work, restart the cytometer. Turn the cytometer off, wait 1 minute, and turn on the cytometer main power.</td>
</tr>
<tr>
<td></td>
<td>3. If connecting still does not work, contact BD Biosciences.</td>
</tr>
</tbody>
</table>
Detector array configurations

This chapter covers the following topics:

- Fluorescence spectra (page 130)
- About configuration maps (page 132)
- About the base configuration (page 133)
- Base configuration polygon maps (page 137)
- Special order configurations (page 150)
Fluorescence spectra

Introduction

This topic shows sample emission spectra from common fluorochromes, as well as the more common laser excitation lines. This information is useful for designing multicolor panels. An interactive fluorescence viewer is also available at bdbiosciences.com.

Designing multicolor panels

The special order BD LSRFortessa X-20 cell analyzer is designed specifically for multicolor research. There are many options for dyes, reagents, and system configurations.

When choosing a configuration or panel, it is important to remember that final results depend on the excitation and emission spectra of the individual dye, the number of fluorescently labeled binding sites on the cell, as well as spectral overlap and spillover to other PMTs. For more information about designing multicolor panels, see Selecting Reagents for Multicolor Flow Cytometry (Part No. 23-9538-02).
Example laser and dye interactions

The following figure shows the emission spectra of some common dyes, based on laser excitation. In many cases, a given dye can be excited by multiple laser wavelengths, yielding different emission intensities.
About configuration maps

**Introduction**  
This topic describes the filter and mirror arrangements in the detector arrays.

**Filter and mirror arrangement**  
The filters are arranged in the detector array to steer progressively shorter wavelengths of light to the next PMT in the array. The longest wavelength should be in the A position and the shortest wavelength should be in the last position used.

There should not be any empty slots for any laser being used. Always use a blank optic holder.

If a slot is filled with a filter or mirror, an identifying number appears in that position on the configuration map. If a slot is filled with a blank optic holder, that position on the configuration map is unlabeled.
About the base configuration

Introduction
This section describes the base configuration options available with the special order BD LSRFortessa X-20 cell analyzer.

Nine available configurations
The base configuration for a BD LSRFortessa X-20 cell analyzer supports detectors, filters, and mirrors for up to five lasers to provide up to 18-color detection.

<table>
<thead>
<tr>
<th>Number of lasers</th>
<th>Colors</th>
<th>Lasers</th>
<th>See section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4</td>
<td>4 Blue</td>
<td>Four-color blue laser configuration (page 139)</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>4 Blue</td>
<td>Four-color blue laser configuration (page 139)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Red</td>
<td>Two-color red laser configuration (page 142)</td>
</tr>
<tr>
<td>7</td>
<td>5 Blue</td>
<td></td>
<td>Five-color blue laser configuration (page 140)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
</tr>
<tr>
<td>8</td>
<td>5 Blue</td>
<td></td>
<td>Five-color blue laser configuration (page 140)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
</tr>
<tr>
<td>Number of lasers</td>
<td>Colors</td>
<td>Lasers</td>
<td>See section...</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td>3</td>
<td>8</td>
<td>4 Blue</td>
<td>Four-color blue laser configuration (page 139)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Red</td>
<td>Two-color red laser configuration (page 142)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>4 Blue</td>
<td>Four-color blue laser configuration (page 139)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Red</td>
<td>Two-color red laser configuration (page 142)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Violet</td>
<td>Two-color violet laser configuration (page 145)</td>
</tr>
<tr>
<td>10</td>
<td>5 Blue</td>
<td>Five-color blue laser configuration (page 140)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>5 Blue</td>
<td>Five-color blue laser configuration (page 140)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Violet</td>
<td>Three-color violet laser configuration (page 146)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>5 Blue</td>
<td>Five-color blue laser configuration (page 140)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 Violet</td>
<td>Six-color violet laser configuration (page 147)</td>
<td></td>
</tr>
<tr>
<td>Number of lasers</td>
<td>Colors</td>
<td>Lasers</td>
<td>See section...</td>
</tr>
<tr>
<td>------------------</td>
<td>--------</td>
<td>--------</td>
<td>----------------</td>
</tr>
<tr>
<td>4</td>
<td>10</td>
<td>4 Blue</td>
<td>Four-color blue laser configuration (page 139)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Red</td>
<td>Two-color red laser configuration (page 142)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Violet</td>
<td>Two-color violet laser configuration (page 145)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
</tr>
<tr>
<td>12</td>
<td>2 Blue</td>
<td>Two-color blue laser configuration (page 138)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Yellow-green</td>
<td>Five-color yellow-green laser configuration (page 149)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>5 Blue</td>
<td>Five-color blue laser configuration (page 140)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Violet</td>
<td>Three-color violet laser configuration (page 146)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>5 Blue</td>
<td>Five-color blue laser configuration (page 140)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3 Red</td>
<td>Three-color red laser configuration (page 143)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 Violet</td>
<td>Six-color violet laser configuration (page 147)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>6 Blue</td>
<td>Six-color blue laser configuration (page 141)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 Red</td>
<td>Four-color red laser configuration (page 144)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 Violet</td>
<td>Six-color violet laser configuration (page 147)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 NUV</td>
<td>Two-color NUV laser configuration (page 148)</td>
<td></td>
</tr>
</tbody>
</table>
**Base configuration**  The special order BD LSRFortessa X-20 cell analyzer has one base configuration at installation. Custom configurations can be added for different applications. The following image shows a default base cytometer configuration.
Upgrade options

The special order BD LSRFortessa X-20 cell analyzer optical configuration can be upgraded to use different special order wavelength options and a variety of detectors. See Special order configurations (page 150) for a list of some common special order laser/detector combinations available through the BD special order research program. Many other special order configurations and options are also available.

More information

- Verifying the configuration and user preferences (page 66)
- Base configuration polygon maps (page 137)

Base configuration polygon maps

Introduction

This section describes how filters and mirrors are arranged for standard polygon configurations.

About the maps

The tables in this section show the detectors, filters, and mirrors used in each configuration, and recommended fluorochromes for each detector. The word “blank” indicates that a blank optical holder should be used instead of an optic holder containing a mirror or filter. A dash (—) indicates that no slot exists for a mirror in that PMT position.
Two-color blue laser configuration

The following map shows the two-color configuration for the 488-nm blue laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>640</td>
<td>695/40</td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td>B</td>
<td>505</td>
<td>525/50</td>
<td>FITC</td>
</tr>
<tr>
<td>C</td>
<td>Blank</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>
The following map shows the four-color configuration for the 488-nm blue laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>PE-Cy™7</td>
</tr>
<tr>
<td>B</td>
<td>685</td>
<td>695/40</td>
<td>PerCP-Cy5.5, PE-Cy™5, PerCP, PI</td>
</tr>
<tr>
<td>C</td>
<td>550</td>
<td>575/26</td>
<td>PE</td>
</tr>
<tr>
<td>D</td>
<td>505</td>
<td>530/30</td>
<td>FITC, Alexa Fluor™ 488</td>
</tr>
<tr>
<td>E</td>
<td>Blank</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>
Five-color blue laser configuration

The following map shows the five-color configuration for the 488-nm blue laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>685</td>
<td>695/40</td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td>C</td>
<td>600</td>
<td>610/20</td>
<td>BD Horizon™ PE-CF594, PE-Texas Red®</td>
</tr>
<tr>
<td>D</td>
<td>550</td>
<td>575/26</td>
<td>PE</td>
</tr>
<tr>
<td>E</td>
<td>505</td>
<td>530/30</td>
<td>FITC, Alexa Fluor™ 488</td>
</tr>
<tr>
<td>F</td>
<td>Blank</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>
Six-color blue laser configuration

The following map shows the six-color configuration for the 488-nm blue laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>685</td>
<td>695/40</td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td>C</td>
<td>655</td>
<td>670/30</td>
<td>PE-Cy5</td>
</tr>
<tr>
<td>D</td>
<td>600</td>
<td>610/20</td>
<td>PE-CF594, PE-Texas Red®</td>
</tr>
<tr>
<td>E</td>
<td>550</td>
<td>575/26</td>
<td>PE</td>
</tr>
<tr>
<td>F</td>
<td>505</td>
<td>530/30</td>
<td>FITC, Alexa Fluor™ 488</td>
</tr>
<tr>
<td>G</td>
<td>Blank</td>
<td>488/10</td>
<td>SSC</td>
</tr>
</tbody>
</table>
**Two-color red laser configuration**

The following map shows the two-color configuration for the 640-nm red laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>APC-Cy7, APC-H7</td>
</tr>
<tr>
<td>B</td>
<td>Blank</td>
<td>670/14</td>
<td>APC</td>
</tr>
</tbody>
</table>
Three-color red laser configuration

The following map shows the three-color configuration for the 640-nm red laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>APC-Cy7, APC-H7</td>
</tr>
<tr>
<td>B</td>
<td>710</td>
<td>730/45</td>
<td>Alexa Fluor™ 700</td>
</tr>
<tr>
<td>C</td>
<td>—</td>
<td>670/14</td>
<td>APC</td>
</tr>
</tbody>
</table>
**Four-color red laser configuration**

The following map shows the four-color configuration for the 640-nm red laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>APC-Cy7, APC-H7</td>
</tr>
<tr>
<td>B</td>
<td>710</td>
<td>730/45</td>
<td>Alexa Fluor™ 700</td>
</tr>
<tr>
<td>C</td>
<td>675</td>
<td>685/35</td>
<td>Alexa Fluor™ 680</td>
</tr>
<tr>
<td>D</td>
<td>—</td>
<td>670/14</td>
<td>APC</td>
</tr>
</tbody>
</table>
Two-color violet laser configuration

The following map shows the two-color configuration for the 405-nm violet laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>475</td>
<td>525/50</td>
<td>AmCyan, Qdot® 525, BD Horizon™ V500-C, BD Horizon™ Brilliant Violet™ BV510</td>
</tr>
<tr>
<td>B</td>
<td>Blank</td>
<td>450/50</td>
<td>Pacific Blue™, BD Horizon™ V450, Marina Blue®, Alexa Fluor™ 405, BD Horizon™ Brilliant Violet™ BV421</td>
</tr>
</tbody>
</table>
Three-color violet laser configuration

The following map shows the three-color configuration for the 405-nm violet laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>595</td>
<td>610/20</td>
<td>Qdot® 605, BD Horizon™ Brilliant Violet™ BV605</td>
</tr>
<tr>
<td>B</td>
<td>475</td>
<td>525/50</td>
<td>AmCyan, V500-C, BV510, Qdot® 525</td>
</tr>
<tr>
<td>C</td>
<td>—</td>
<td>450/50</td>
<td>Pacific Blue™, V450, BV421, Marina Blue®, Alexa Fluor™ 405</td>
</tr>
</tbody>
</table>
Six-color violet laser configuration

The following map shows the six-color configuration for the 405-nm violet laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>630</td>
<td>655/8</td>
<td>Qdot® 655</td>
</tr>
<tr>
<td>B</td>
<td>595</td>
<td>610/20</td>
<td>BV605, Qdot® 605</td>
</tr>
<tr>
<td>C</td>
<td>575</td>
<td>585/15</td>
<td>Qdot® 585</td>
</tr>
<tr>
<td>D</td>
<td>545</td>
<td>560/20</td>
<td>Qdot® 565</td>
</tr>
<tr>
<td>E</td>
<td>475</td>
<td>525/50</td>
<td>AmCyan, V500-C, BV510, Qdot® 525</td>
</tr>
<tr>
<td>F</td>
<td>Blank</td>
<td>450/50</td>
<td>Pacific Blue™, V450, BV421, Marina Blue®, Alexa Fluor™ 405</td>
</tr>
</tbody>
</table>
Two-color NUV laser configuration

The following map shows the two-color configuration for the 375-nm near-UV (NUV) laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>505</td>
<td>530/30</td>
<td>Indo-1 (Blue)</td>
</tr>
<tr>
<td>B</td>
<td>Blank</td>
<td>450/50</td>
<td>Indo-1 (Violet), DAPI, Alexa Fluor™ 350</td>
</tr>
</tbody>
</table>
Five-color yellow-green laser configuration

The following map shows the five-color configuration for the 561-nm yellow-green laser.

<table>
<thead>
<tr>
<th>PMT</th>
<th>LP mirror</th>
<th>BP filter</th>
<th>Fluorochromes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>750</td>
<td>780/60</td>
<td>PE-Cy7</td>
</tr>
<tr>
<td>B</td>
<td>685</td>
<td>710/50</td>
<td>PerCP-Cy5.5</td>
</tr>
<tr>
<td>C</td>
<td>635</td>
<td>670/30</td>
<td>PE-Cy5</td>
</tr>
<tr>
<td>D</td>
<td>600</td>
<td>610/20</td>
<td>PE-CF594, PE-Texas Red®</td>
</tr>
<tr>
<td>E</td>
<td>Blank</td>
<td>586/15</td>
<td>PE</td>
</tr>
</tbody>
</table>

More information
- About the base configuration (page 133)
- Special order configurations (page 150)
Special order configurations

**Introduction**
This topic describes some of the more common configurations available through the special order research program.

**Available options**
The special order BD LSRFortessa X-20 cell analyzer can be configured with up to 5 lasers choosing from 11 different special order wavelength options and a variety of detectors. This section shows some of the common special order laser/detector combinations. Contact your local BD Biosciences sales representative for information about other configurations.

**BP filters used with CS&T**
Not all combinations of special order BP filters and lasers are normalized to CS&T settings. In this case, CS&T will generate Qr and Br numbers that are not comparable from instrument to instrument. Care should be taken when interpreting the CS&T reported Qr values on special order BD LSRFortessa X-20 instruments. Please see the latest published filter guides available on our website (bdbiosciences.com) for more information.

**Blue 488 nm (20–100 mW)**
The fluorochromes listed in the following table can be used with this laser wavelength for cell surface markers, live/dead discrimination, and cell cycle applications. See Common blue laser configurations (page 155) for common polygon configuration maps.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSC</td>
<td>488/10</td>
</tr>
<tr>
<td>FITC, Alexa Fluor™ 488</td>
<td>530/30</td>
</tr>
<tr>
<td>PE</td>
<td>575/25</td>
</tr>
<tr>
<td></td>
<td>575/26</td>
</tr>
<tr>
<td></td>
<td>576/26</td>
</tr>
<tr>
<td></td>
<td>585/42</td>
</tr>
</tbody>
</table>
The fluorochromes listed in the following table can be used with this laser wavelength for the cell surface marker application. See Common red laser configurations (page 157) for two common polygon configuration maps.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE-CF594, PE-Texas Red®, PI</td>
<td>605/12</td>
</tr>
<tr>
<td></td>
<td>610/20</td>
</tr>
<tr>
<td></td>
<td>616/23</td>
</tr>
<tr>
<td>PE-Cy5</td>
<td>660/20</td>
</tr>
<tr>
<td></td>
<td>670/30</td>
</tr>
<tr>
<td>PerCP, PerCP-Cy5.5, PE-Cy5.5</td>
<td>670/14</td>
</tr>
<tr>
<td></td>
<td>675/20</td>
</tr>
<tr>
<td></td>
<td>695/40</td>
</tr>
<tr>
<td></td>
<td>710/50</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>780/60</td>
</tr>
<tr>
<td>APC, Alexa Fluor™ 647</td>
<td>670/30</td>
</tr>
<tr>
<td>Alexa Fluor™ 680</td>
<td>685/35</td>
</tr>
<tr>
<td>Alexa Fluor™ 700</td>
<td>710/50</td>
</tr>
<tr>
<td></td>
<td>710/20</td>
</tr>
<tr>
<td></td>
<td>712/21</td>
</tr>
<tr>
<td></td>
<td>730/45</td>
</tr>
<tr>
<td>APC-Cy7, APC-H7</td>
<td>780/60</td>
</tr>
</tbody>
</table>
The fluorochromes listed in the following table can be used with this laser wavelength for cell surface marker, live/dead discrimination, and cell cycle applications. See Common violet laser configurations (page 158) for common polygon configuration maps.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>V450, BV421, Pacific Blue™</td>
<td>450/50</td>
</tr>
<tr>
<td></td>
<td>450/40</td>
</tr>
<tr>
<td></td>
<td>450/20</td>
</tr>
<tr>
<td></td>
<td>440/40</td>
</tr>
<tr>
<td>AmCyan, Alexa Fluor™ 430, V500-C, BV510, DAPI</td>
<td>510/50</td>
</tr>
<tr>
<td></td>
<td>525/50</td>
</tr>
<tr>
<td>Qdot® 525</td>
<td>NA</td>
</tr>
<tr>
<td>Qdot® 545</td>
<td>NA</td>
</tr>
<tr>
<td>Qdot® 565</td>
<td>560/20</td>
</tr>
<tr>
<td></td>
<td>560/40</td>
</tr>
<tr>
<td>Qdot® 585</td>
<td>585/15</td>
</tr>
<tr>
<td></td>
<td>585/42</td>
</tr>
<tr>
<td>BV605, Qdot® 605</td>
<td>605/12</td>
</tr>
<tr>
<td></td>
<td>605/40</td>
</tr>
<tr>
<td></td>
<td>610/20</td>
</tr>
<tr>
<td>Qdot® 655</td>
<td>655/8</td>
</tr>
<tr>
<td></td>
<td>670/30</td>
</tr>
<tr>
<td>BD Horizon™ Brilliant Violet™ BV711, Qdot® 700, Qdot® 705</td>
<td>710/50</td>
</tr>
<tr>
<td></td>
<td>712/20</td>
</tr>
<tr>
<td>Qdot® 800</td>
<td>780/60</td>
</tr>
<tr>
<td></td>
<td>800/30</td>
</tr>
</tbody>
</table>

**Note:** If a 561-nm yellow-green laser is configured, a 561 notch filter is required for Qdot® 565 and Qdot® 585.

**Note:** The 800/30 bandpass filter is a special order research program filter.
UV 355 nm (20–100 mW)  
The fluorochromes listed in the following table can be used with this laser wavelength for the cell cycle application with the DAPI and Hoechst fluorochromes. The wavelength is used for the Ca\(^{2+}\) flux application with both Indo-1 fluorochromes. See Common UV laser configurations (page 160) for two common polygon configuration maps.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>DAPI, Hoechst</td>
<td>440/40</td>
</tr>
<tr>
<td></td>
<td>450/20</td>
</tr>
<tr>
<td></td>
<td>450/40</td>
</tr>
<tr>
<td></td>
<td>450/50</td>
</tr>
<tr>
<td>Indo-1 (Ca Bound)</td>
<td>450/50</td>
</tr>
<tr>
<td>Indo-1 (Ca unbound)</td>
<td>530/30</td>
</tr>
</tbody>
</table>

Yellow-green 561 nm (50 mW)  
The fluorochromes listed in the following table can be used with this laser wavelength for cell surface marker and fluorescent protein applications. See Common yellow-green laser configuration (page 162) for a common polygon configuration map.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE, DsRed</td>
<td>586/15</td>
</tr>
<tr>
<td>PE-CF594, PE-Texas Red®, mCherry</td>
<td>610/20</td>
</tr>
<tr>
<td>PE-Cy5</td>
<td>660/20</td>
</tr>
<tr>
<td></td>
<td>670/30</td>
</tr>
<tr>
<td>PE-Cy5.5</td>
<td>710/50</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>780/60</td>
</tr>
</tbody>
</table>
The fluorochromes listed in the following table can be used with this laser wavelength for the cell surface markers application. See Common green laser configuration (page 163) for a common polygon configuration map.

<table>
<thead>
<tr>
<th>Fluorochromes</th>
<th>BP filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PE</td>
<td>575/25</td>
</tr>
<tr>
<td>PE-CF594, PE-Texas Red®</td>
<td>610/20</td>
</tr>
<tr>
<td>PE-Cy5</td>
<td>660/20</td>
</tr>
<tr>
<td>PE-Cy5.5</td>
<td>660/20</td>
</tr>
<tr>
<td>PE-Cy5.5</td>
<td>670/30</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>695/40</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>710/50</td>
</tr>
<tr>
<td>PE-Cy7</td>
<td>780/60</td>
</tr>
</tbody>
</table>
Common blue laser configurations

The following maps show two common configurations for the 488-nm blue laser.
**Note:** With the 488-nm blue laser, FITC requires a 525/50 notch filter if the cytometer also uses a 532-nm laser.
Common red laser configurations

The following maps show two common configurations for the 640-nm red laser.
Common violet laser configurations

The following maps show two common configurations for the 405-nm violet laser.
Note: If a 561-nm yellow-green laser is configured, a 561 notch filter is required for Qdot® 565 and Qdot® 585.
The following maps show two common configurations for the 355-nm UV laser.
The following map shows a common configuration for the 561-nm yellow-green laser.

**Note:** When you use a PE conjugate with a 561-nm laser, you must replace the 585/42 bandpass filter (BP) with a 582/15 BP, regardless of which laser (blue, green, or yellow-green) is exciting the PE fluorochromes.
Common green laser configuration

The following map shows a common configuration for the 532-nm green laser.
This page intentionally left blank
Manual settings

This chapter covers the following topics:

- About laser delay (page 166)
- Optimizing laser delay (page 167)
- Adjusting area scaling (page 169)
About laser delay

Introduction

This topic describes how to manually set the laser delay if you are not using CS&T for cytometer setup and tracking.

About laser signal delay

Sample interrogation takes place within the cuvette flow cell. Laser light is directed through a series of prisms that focus multiple lasers on the event stream at different positions. This allows optimal detection of fluorescent signals from each laser with minimal cross-contamination from the other beams.

For example, in a BD LSRFortessa X-20 four-laser system, the blue laser intercepts the stream first, followed by the violet, UV, and red lasers. Because the laser signals are spatially separated, there is a slight delay between the detection of each laser’s signal.

*The yellow-green laser is only available through the BD special order research program.

The laser delay setting in BD FACSDiva software is used to re-align the signals so they can be measured and displayed on the same time scale. Signals are aligned with respect to the blue laser, so the blue laser will have a 0 delay value, and the red laser will have the longest delay.
Optimizing laser delay

Introduction

This topic describes how to optimize the laser delay using BD FACSDiva software.

Before you begin

To optimize the delay for a given laser, you must acquire events from a sample with a fluorescence signal excited by that laser. Follow the procedures in Recording and analyzing data (page 85), for sample optimization and acquiring data.

Procedure

To optimize laser delay:

1. While acquiring data from your sample, create a histogram to show the fluorescence signal excited by the laser for which the delay is to be optimized.

2. In the Acquisition Dashboard, set the Events to Display to 500 events.

3. Click the Laser tab in the Cytometer window.

Window extension and laser delay values are displayed in microseconds (µs).
4. Set the **Window Extension** value to 0 µs.

5. Set an initial laser delay value **only** for the laser you are optimizing.
   - If you are optimizing the violet laser, set its delay to 40 µs.
   - If you are optimizing the UV laser, set its delay to 75 µs.
   - If you are optimizing the red laser, set its delay to 110 µs.

6. While observing the positive events on the histogram, adjust the laser delay in 1-µs increments. You might need to adjust the delay above or below the initial setting.
   
   Choose the setting that moves the events farthest to the right (highest fluorescence intensity).

7. Draw an interval gate on the histogram for the positive events.

8. Create a statistics view to display the mean fluorescence intensity (MFI) of the gated population.

9. While observing the MFI for the gated population, adjust the laser delay in 0.1-µs increments within a range of 2.0 µs of the setting obtained in step 6.
   
   Preserve the setting that maximizes the fluorescence intensity.

10. Reset the **Window Extension** to 10 µs.
Adjusting area scaling

Introduction
This topic describes how to manually adjust the area scaling on your cytometer if necessary for your application. The area scaling is automatically set in CS&T. Depending on the size of your target particle, you might need to adjust the area scaling manually. Larger particles are more likely to require an area scaling adjustment.

About area scaling
The area of a pulse is calculated by BD FACSDiva using measured height and width measurements. It is sometimes important to verify that the area calculation and the height measurement are equivalent by adjusting the factor applied to the area. The required area scaling factor changes based on sheath pressure and particle size.

About this example
The following example describes how to adjust area scaling for an experiment which uses only the 488-nm laser and the 640-nm laser. You must adjust area scaling for all lasers used in your experiment. To adjust the other lasers, add a parameter and the corresponding plots from that laser to the procedure.

Procedure
To adjust area scaling:
1. Open an existing experiment, or create a new experiment in the Browser.

2. Create a new specimen by clicking the New Specimen button on the Browser toolbar.
3. In the **Inspector**, click the **Parameters** tab and select the **H** checkbox to select height for each parameter.

4. On the global worksheet, create the following plots and histograms:
   - FSC vs SSC dot plot
   - FSC-H and FSC-A histogram
   - FITC-H and FITC-A histogram
   - APC-H and APC-A histogram

5. Create a P1 gate in the FSC vs SSC plot, and show only the P1 population in all histograms.
6. Create three statistic views showing the following:
   - FSC-H and FSC-A means for P1
   - FITC-H and FITC-A means for P1
   - APC-H and APC-A means for P1
   
   Your worksheet should look similar to the following figure.

7. Expand the new specimen, then set the current tube pointer to *tube_001*. 
8. Install the FITC-positive control tube onto the loading port and click **Load** in the **Acquisition Dashboard**.

9. Adjust the FSC and SSC voltages to place the particles on scale.

10. Adjust the P1 gate around the population of interest.

11. Adjust the FSC area scaling.
   a. Click the **Laser Tab** in the **Cytometer** window.
   b. Adjust the FSC area scaling factor until the FSC-A signal matches the FSC-H signal:
   
   - Increase the area scaling factor if the FSC-A signal is lower than FSC-H.
- Decrease the area scaling factor if the FSC-A signal is higher than FSC-H.

12. Adjust the blue laser area scaling factor until the FITC-A signal matches the FITC-H signal, if needed.

13. Unload the FITC-positive control tube, then load the APC-positive control tube.
14. Adjust the red laser area scaling factor until the APC-A signal matches the APC-H signal, if needed.
This chapter covers the following topics:

- Ordering information (page 176)
- Beads (page 176)
- Reagents (page 177)
- Equipment (page 178)
Ordering information

To order spare parts and consumables from BD Biosciences:

- Within the US, call (877) 232-8995.
- Outside the US, contact your local BD Biosciences customer support representative.

Worldwide contact information can be found at bdbiosciences.com.

Beads

Introduction

This topic lists the QC and CS&T beads available.

QC particles

<table>
<thead>
<tr>
<th>Particle</th>
<th>Laser</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPHERO™ Rainbow Calibration Particles (8 peaks)</td>
<td>All</td>
<td>BD Biosciences</td>
<td>559123</td>
</tr>
<tr>
<td>SPHERO Ultra Rainbow Fluorescent Particles (single peak)</td>
<td>All</td>
<td>Spherotech, Inc.</td>
<td>URFP-30-2</td>
</tr>
<tr>
<td>BD DNA QC Particles</td>
<td>Blue (488 nm)</td>
<td>BD Biosciences</td>
<td>349523</td>
</tr>
</tbody>
</table>
### CS&T beads

<table>
<thead>
<tr>
<th>Bead</th>
<th>Laser</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD FACS Diva CS&amp;T research beads</td>
<td>UV (355 nm and 375 nm)• Violet (405 nm)• Blue (488 nm)• Red (640 nm)• Yellow-green (561 nm)• Green (532 nm)</td>
<td>BD Biosciences</td>
<td>655050 (50 tests) 655051 (150 tests)</td>
</tr>
</tbody>
</table>

### Reagents

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD FACSFlow sheath fluid</td>
<td>BD Biosciences</td>
<td>342003</td>
</tr>
<tr>
<td>BD FACS™ sheath solution with surfactant (recommended for use with the HTS option)</td>
<td>BD Biosciences</td>
<td>336524</td>
</tr>
<tr>
<td>Monoclonal antibodies</td>
<td>BD Biosciences</td>
<td>See the BD Biosciences Product Catalog or the BD Biosciences website (bdbiosciences.com)</td>
</tr>
<tr>
<td>BD FACS™ lysing solution</td>
<td>BD Biosciences</td>
<td>349202</td>
</tr>
<tr>
<td>BD Detergent Solution Concentrate</td>
<td>BD Biosciences</td>
<td>660585</td>
</tr>
<tr>
<td>Reagent</td>
<td>Supplier</td>
<td>Catalog No.</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>BD FACSClean solution</td>
<td>BD Biosciences</td>
<td>340345</td>
</tr>
<tr>
<td>Dyes and fluorochromes</td>
<td>BD Biosciences, Life Technologies, or Sigma</td>
<td>–</td>
</tr>
<tr>
<td>Chlorine bleach (5% sodium hypochlorite)</td>
<td>Clorox® or other major supplier (to ensure that the bleach is at the correct concentration and free of particulate matter)</td>
<td>–</td>
</tr>
</tbody>
</table>

## Equipment

<table>
<thead>
<tr>
<th>Equipment item</th>
<th>Supplier</th>
<th>Catalog No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bal seal</td>
<td>BD Biosciences</td>
<td>343509</td>
</tr>
<tr>
<td>O-ring, sample tube</td>
<td></td>
<td>343615</td>
</tr>
<tr>
<td>Sheath filter assembly</td>
<td></td>
<td>345734</td>
</tr>
<tr>
<td>Falcon polystyrene test tubes, 12 x 75-mm</td>
<td>Corning</td>
<td>352008</td>
</tr>
</tbody>
</table>
Index

Numerics

355-nm UV laser  153, 160
375-nm near-UV laser  148
405-nm violet laser  145–147, 152, 158
488-nm blue laser  139–141, 150, 155
532-nm green laser  154, 163
561-nm yellow-green laser  153, 162
640-nm red laser  142–144, 151, 157

A

acridine orange (AO)  47
air bubbles, removing  33
alarm
  battery test  52
  waste container  23
analysis
  data  86
  immunophenotyping  91
  reusing  97
  saving  97
antibodies  102
AO See acridine orange
application settings
  applying  87
  creating  76
area scaling  169
arm, tube support  21
aspiration (sample), rapid  119
assistance, technical  13

B

Bal seal
  ordering  178
  replacing  58
bandpass (BP) filters
  detector array placement  25
  theory  107
base configurations  137
battery
  changing  53
  test  52
BD Detergent Solution Concentrate  48
BD FACSClean solution  178
BD FACSDiva software See software
BD FACSflow sheath fluid  177
BD FACSFlow solution  33
BD FACSFlow supply system  30, 49
BD High ThroughputSampler (HTS)  22
blank optical holders  41
bleach  46, 178
blue 488-nm laser  139–141, 150, 155
BP See bandpass filters
bubbles, removing air  34
buttons
  fluid control  20
  sample flow rate control  19

calculating compensation  82
capacity, waste container  23
cleaning solutions 46
compensation
  calculating 82
  control tubes 79
  recording settings 80
  theory 109
components
  cytometer shown 17
  sheath container shown 32
  sheath filter shown 56
  waste container shown 37
computer system, about 27
configuration
  base 133
  BD FACSDiva 66
containers
  sheath 23, 31
  waste 23, 36, 38
control panel, cytometer 18
controls
  fluidics 18
  single-stained 65, 86
conventions
  safety symbols 11
creating
  analysis objects 91
  global worksheets 87
  statistics view 91
CS&T particles 177
cuvette flow cell 166
CV, troubleshooting 125
cytometer 16
  components shown 17
  configuration 41, 66
  disconnect error 127
  door and drawer 42
  setup 64
  starting 30
  troubleshooting 118

D
DAPI, cleaning after using 47
data
  analyzing 86, 91
  gating 91
  recording 86, 88
debris, excessive 124
default configuration 133
delay, laser 166
detector arrays 24
detectors 26
dichroic mirrors
  theory 108
digital data 16
digital electronics 114
Diva software See software
DNA, flow rate for analysis 101
droplet containment system 22

E
electronics
  digital 114
  laser controls 115
  pulse 112
  pulse measurements 113
  threshold 114
  troubleshooting 127
emission duration 112
event rate
  erratic 123
  high 122
  low 123
  zero 119, 121
excessive debris 124
excitation wavelength 102
experiments
  creating 72
  immunophenotyping 87
  sample optimization 72
specifying parameters 73

F
FACSFLOW sheath fluid 177
FACSFLOW solution 33
Falcon tubes 119
filters, optical
  bandpass (BP) 25, 107
  changing 42
  dichroic See dichroic mirrors
  longpass (LP) 104, 105
  notch 105, 156
  shortpass (SP) 104, 106
  theory 104
filters, sheath
  attaching new 57
  replacing 56
FITC and Stokes shift 103
fixed-alignment lasers 16
flow cell
  draining 39
  fluidics 100
flow rate control buttons 19
fluid control buttons
  PRIME 20
  RUN 20
  STANDBY 20
fluidics
  description 19, 100
  flow rate control 19
  flushing system 50
  priming 39
  removing air bubbles 34
  run mode 20
  sample injection port (SIP) 21
fluidics controls, cytometer 18
fluidics interconnect 35
fluorescence
  defined 102
  emission 112
  fluorescence signal, none 122
fluorochromes
  compensation theory 109
  emission spectra 103
  measured 41
  role in light emission 102
flushing the system 50
forward scatter (FSC) 102
FSC See forward scatter

G
gating data 91
global worksheets
  analyzing data 91
  creating 87
  previewing data 86, 97
green 532-nm laser 154, 163

H
hazard symbol definitions 11
Help, accessing 12
High Throughput Sampler (HTS) 22
hydrodynamic focusing 100

I
immunophenotyping
  analysis 91
  experiment 87
  hydrodynamic focusing 101

K
knob, SAMPLE FINE ADJ 19

L
laser delay
  about 166
  optimizing 167
options  24
  performance check  68
quality control (QC) particles  176
longpass (LP) filters
  defined  104
  theory  105
LP See longpass filters

M
maintenance
  Bal seal  58
  battery change  53
  battery test  52
  cytometer shutdown  49
  sample tube O-ring  60
  schedule  47
  scheduled  50
  sheath filter  56
  system flush  50
  waste management system  52
mirrors, dichroic longpass (LP) filter  25

N
notch filters  105, 156

O
online Help  12
optic holder  41
optics
  components  23
  configuration  66, 67
  dichroic mirrors  108
  filters  25, 42, 104
  location  17
optimization, sample  64
ordering spare parts  176
O-ring
  ordering  178
  replacing  60
worn  118

P
particles  176, 177
PerCP, Stokes shift  102
performance check  68, 69
photodiode  26
photomultiplier tubes (PMTs)  26
PMT See photomultiplier tubes
polygon
  location  42
  shown  25
population hierarchy  91
power switch  17, 18
PRIME, fluid control button  20
priming fluidics system  39
propidium iodide (PI)  47
pulse
  definition  112
  measurements  113
  processors  113

Q
quality control (QC)
  particles  176
troubleshooting  125

R
recording
  compensation settings  80
  compensation tubes  79
data  86, 88
red 640-nm laser  142–144, 151, 157
removing air bubbles, filter  34
replacing
  Bal seal  58
  battery  53
  optical filters  42
  sample tube O-ring  60
Index

sheath filter 56
waste air filter 55
reusing analyses 97
RUN
button orange 121
fluid control button 20

S
safety symbol definitions 11
safety symbols 11
sample
optimization 64
optimization experiment 72
optimization, single-stained controls 65, 86
SAMPLE FINE ADJ knob 19
sample injection port (SIP) components 21
hydrodynamic focusing 100
location 17
replacing Bal seal 58
replacing sample tube O-ring 60
sample tube
injection 21
not fitting 119
requirements 119
samples, running 88
saving analyses 97
scatter
light 102
parameter distortion 124
setup, cytometer 64
sheath
flow 100
pressure 100
sheath container
components shown 32
defined 23
depressurize 32
preparing 32
sheath filter
components shown 56
ordering 178
removing air bubbles 33
replacing 56
sheath fluid 100
backflush 22
BD FACSFlow sheath fluid 177
shortpass (SP) filters 104, 106
side scatter (SSC) 102
signals, amplifying 26
SIP See sample injection port
software
cytometer control 10
version 27
spare parts, ordering 176
spillover 109
SSC See side scatter
STANDBY, fluid control button 20
starting cytometer 30
statistics views 91
Stokes shift 102
support, technical 13

T
technical assistance 13
testing battery 52
thiazole orange (TO) 47
threshold, defined 114
TO See thiazole orange
troubleshooting
cytometer 118
electronics 127
tubes
Falcon 119
requirements 119

U
user preferences 67
UV 355-nm laser 153, 160

**V**
violet 405-nm laser 145–147, 152, 158

**W**
waste air filter
  component *shown* 37
  replacing 55
waste air vent filter
  replacing 121
waste container 23
  alarm 23
  battery test 52
  capacity 23
  components *shown* 37
  defined 23
  emptying 36
  pressurized 38, 121
  replacing battery 53
window extension 167
workstation, about 27

**Y**
yellow-green 561-nm laser 153, 162